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Copyright and Trademark Notice

Copyright

All material contained in this document is protected by copyright law.

©2014 Arpelligo, Inc. (dba Accountable Software) All Rights Reserved

Trademarks

Forms Printer is a trademark of Arpelligo, Inc. (dba Accountable Software). Other company or product names
mentioned may be trademarks or registered trademarks of their respective holders.

Microsoft Dynamics is a trademark of Microsoft Corporation in the United States and/or other countries.

Microsoft product screenshots reprinted with permission from Microsoft Corporation.
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Understanding Forms Printer Modules

This document refers to Forms Printer and to its three separately licensed modules that are included
within the installation of Forms Printer. Those modules are:

Forms Printer Base System:
The Base System allows you to control delivery of very specific documents in the main Dynamics
GP product. This integration is very seamless and allows for processing of these documents by
batch, range and in every GP window that supports that document type. The list of supported
documents includes: SOP, POP, RM Transactions, RM Statements, Invoicing Module Invoices, and
Payroll and Payables Checks.

Forms Printer Base System DOES NOT include the functionality of Forms Printer Plus or Forms
Printer for Project.

Form Printer Plus

Forms Printer Plus allows printing of documents not integrated to by Forms Printer Base System or
Forms Printer for Project, allowing you to define the window and button that will launch the
report. This can include windows from Add-On modules, 3" party products and customizations.

The Forms Printer Plus module includes the functionality of the Forms Printer Base System but
DOES NOT include the functionality of Forms Printer for Project.

Forms Printer for Project Accounting
Forms Printer for Project Accounting allows a tight integration to the Project Invoice and PO
printing processes and offers delivery of these documents just as the Base System offers.

Forms Printer for Project DOES NOT include the functionality of Forms Printer Base System or
Forms Printer Plus.

We highly recommend that you understand the integration of the Forms Printer Base System and Forms
Printer for Project as related to printing their supported documents. This method is preferred for printing
as it is a more comprehensive integration to Transactional processing than offered by forms Printer Plus.
Please contact our sales and / or support teams with any questions on which module will be most
productive for your needs.

Any reference to Forms Printer without a module qualification is intended to indicate that the information
applies to all of the modules.
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Installation of Forms Printer

The installation process detailed below applies to all of Forms Printer whether you are installing Forms
Printer Base System, Forms Printer for Project Accounting or Forms Printer Plus.

The initial installation of Forms Printer is performed in several steps. First is the installation of the initial
Forms Printer client application. Next, the Forms Printer client code is included in the Microsoft
Dynamics™ GP client application set. Following the code inclusion is the installation of SQL Server objects
and data. Next, the Forms Printer Registration keys are entered to enable the application. Once Forms
Printer is registered, the next three setup steps can be completed in whatever order you wish. These steps
are to install additional workstations with the client application, to enter Roles and Tasks in the new
Dynamics GP security models and to add Report Engine Setup information.
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Installation Checklist

Step | Description

1. Download the latest version of Forms Printer

2. Obtain Registration Keys for the Downloaded Version

3. Runtheinstallation executable on the first workstation

4. Launch Dynamics GP using an Administrative user

5. Include new code

6. Install and Initialize tables in first Company

7. Enter Registration Keys

8. Install and Initialize tables in additional Companies

9. Add Dynamics GP Roles and Tasks

10. Enter Report Engine Setup Information

11. Enter Forms Printer Setup Information

12. Add Reports to Forms Printer Plus
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Installing the First Forms Printer Client Application
The installation of the initial Forms Printer client application is different than subsequent installs because

3 additional steps must be followed. Those steps are to: Include Forms Printer in the Dynamics GP

Installation, Enter Forms Printer Registration Keys, and Install SQL Server Objects in Additional Companies.

Run the Forms Printer Installation File
Complete the following steps to install the Forms Printer client application on the FIRST Dynamics GP

client workstation:

1. Download the Forms Printer Installation File

a.

Download the latest version of Forms Printer. Checking our web site for the most current
version of the product before installation ensures that any updates or fixes are installed
and is highly recommended.

The file downloaded from the Accountable Software Resource Center will contain an
installation file named Forms Printer XXXX.msi (where the XXXX will be the installing
version).

2. Double Click on the setup.msi installer file to begin the installation.

3. Follow the installation wizard to complete the installation of Forms Printer.

a.
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The installation program begins with a “Welcome” window. Take a moment to verify that
the proper version for you Dynamics GP application is being installed.

When ready, click Next>.

Review the license agreement, and if you agree, confirm your acceptance to the terms
described within by clicking | Agree. Note: You cannot install Forms Printer if you do not
accept the terms.

When ready, click Next>.

Review the Additional License Agreement required for using the Business Objects
Runtime. If you agree, confirm your acceptance to the Business Objects terms described
within by clicking | Agree. Note: You cannot install Forms Printer if you do not accept the
terms.

When ready, click Next>.

Select the folder in which the Microsoft Dynamics™ GP application is installed. This folder
is typically located on your local hard drive. The install program will attempt to default the
installation to The Microsoft Dynamics™ GP Application folder. If the detected folder is
not the location where Microsoft Dynamics™ GP is installed on your machine you will
need to select the correct folder in which to install Forms Printer.

When ready, click Next>.

The Confirmation window provides a final opportunity to ensure the proper version
installed.



When ready, click Next>.
The setup program will then begin to copy all files to the appropriate directories.

f.  When the installation has completed the final Information window displays important
information on documentation and other file locations.

When ready, click Next>.
g. The installation complete window is displayed.
When ready, click Close.

Include Forms Printer in the Dynamics GP Installation
1. Launch Microsoft Dynamics™ GP as Administrator (or user with administrative privileges)

2. Loginas ‘sa’ or a database administrator.

3. A dialog window prompting to include the new code will be displayed, as shown in the following
illustration:

Click Yes, and wait until the process has completed.

Dexterity Runtime

i MNew code must be included in the :D:Program FilesiMicrosoft
\‘) DynamicsiGP10/Dynamics.set dictionary. Do you wish to include
new code now?

A progress bar will display, while the “unchunking” process is executing. At this point, our
DYNAMICS.SET file will be modified to include the information required to run Forms Printer, and two
dictionaries named “FPD1230.DIC” and ”ASI1655.DIC” will be created in your Microsoft Dynamics™ GP
application folder.

Install SQL Server Objects
After the new code is loaded, you must install Forms Printer to the SQL Server Database and will be

prompted to do so. When prompted, using the steps below and you must repeat this database installation
for each Dynamics GP Company by logging into each company and repeating the steps:

1. When presented with the dialog window prompting to install and initialize Custom Report
Integration tables click Yes to initialize the new tables.

2. When presented with the dialog window prompting to install and initialize Forms Printer tables
click Yes to initialize the new tables.
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3.

If running the Project Accounting module, you will be prompted with the dialog window asking to
initialize Project Accounting tables click Yes to initialize the new tables.

Enter Forms Printer Registration Keys
Once the Database installation is completed you will be presented with the message to enter registration
keys in companies other than the Lesson Company. To register Forms Printer follow these steps:

1.

When prompted to register, click Yes to open the Forms Printer Registration window.

If no registration prompt is presented, open the Accountable Software Registration window by
clicking the Help icon, then selecting About Microsoft Dynamics™ GP. The About Microsoft
Dynamics™ GP window will open and a Forms Printer Registration window will open as a
companion window.

Click the Register button to open the Forms Printer Registration window.

Enter the registration keys exactly as you received them from Accountable Software for your
Microsoft Dynamics™ GP installation. Registration keys are provided by Accountable Software
directly. For more information or to obtain your registration keys, please call (610) 983-3100 or
email sales@accountable.com.

If you mistyped the keys, you will receive a warning message. Try again. If you still receive a
warning, contact Accountable Software for assistance at techsupport@accountable.com.

Click Register. If you mistyped the keys, you will receive a warning message. Try again. If you still
receive a warning, contact Accountable Software for assistance at techsupport@accountable.com.

Verify the Registration Keys.

If the module(s) you are registering appear with a checkbox in the Registered column, the
registration was successful.

Click the Close.

Install SQL Server Objects in Additional Companies
To complete the SQL Server installation process, it is required that the following steps are completed for
each Company:

1.
2.

Log in as ‘sa’ or a database administrator.

When presented with the dialog window prompting to install and initialize Custom Report
Integration tables click Yes to initialize the new tables.

When presented with the dialog window prompting to install and initialize Forms Printer tables
click Yes to initialize the new tables.

If running the Project Accounting module, you will be prompted with the dialog window asking to
initialize Project Accounting tables click Yes to initialize the new tables.

Installing Forms Printer on Additional Workstations
In order to use Forms Printer on additional workstations, you must follow the client installation steps on

those workstations. Be sure to install the same version on all workstations. Note that once the previous

steps have been completed the SQL Server installation and registration key entry is completed and does

not need to be repeated. For additional workstation installs, follow these steps:
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Run the Forms Printer Installation File
Complete the following steps to install the Forms Printer client application on the FIRST Dynamics GP

client workstation:

1. Download the Forms Printer Installation File

a.

b.

Download the latest version of Forms Printer. Checking our web site for the most current
version of the product before installation ensures that any updates or fixes are installed
and is highly recommended.

The file the Accountable Software Resource Center will contain an installation file named
Forms Printer XXXX.msi (where the XXXX will be the installing version).

2. Double Click on the setup.msi installer file to begin the installation.

3. Follow the installation wizard to complete the installation of Forms Printer.

a.
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The installation program begins with a “Welcome” window. Take a moment to verify that
the proper version for you Dynamics GP application is being installed.

When ready, click Next>.

Review the license agreement, and if you agree, confirm your acceptance to the terms
described within by clicking | Agree. Note: You cannot install Forms Printer if you do not
accept the terms.

When ready, click Next>.

Review the Additional License Agreement required for using the Business Objects
Runtime. If you agree, confirm your acceptance to the Business Objects terms described
within by clicking | Agree. Note: You cannot install Forms Printer if you do not accept the
terms.

When ready, click Next>.

Select the folder in which the Microsoft Dynamics™ GP application is installed. This folder
is typically located on your local hard. The install program will attempt to default the
installation to The Microsoft Dynamics™ GP Application folder. If the detected folder is
not the location where Microsoft Dynamics™ GP is installed on your machine you will
need to select the correct folder in which to install Forms Printer.

When ready, click Next>.

The Confirmation window provides a final opportunity to ensure the proper version
installed.

When ready, click Next>.
The setup program will then begin to copy all files to the appropriate directories.

When the installation has completed the final Information window displays important
information on documentation and other file locations.



When ready, click Next>.
g. The installation complete window is displayed.
When ready, click Close.

Include Forms Printer in the Dynamics GP Installation
1. Launch Microsoft Dynamics™ GP as Administrator (or a user with administrative privileges).

2. Loginas ‘sa’ or a database administrator.

3. A dialog window prompting to include the new code will be displayed, as shown in the following
illustration:

Click Yes, and wait until the process has completed.

A progress bar will display, while the “unchunking” process is executing. At this point, our DYNAMICS.SET
file will be modified to include the information required to run Forms Printer, and two dictionaries named
“FPD1230.DIC” and "ASI1655.DIC” will be created in your Microsoft Dynamics™ GP application folder.

Uninstalling Forms Printer

If it becomes necessary to temporarily disable Forms Printer on a Microsoft Dynamics™ GP workstation, one
can use the Microsoft Dynamics™ GP Tools->Customization->Customization Status Window to Disable the
Forms Printer product for one login Session.

In order to more permanently disable Forms Printer on a Workstation, one must edit the Microsoft
Dynamics™ GP “Launch” file (typically named dynamics.set) to remove references to the Forms Printer
Product (ID = 1230), and the Supporting “CRI” component (Product ID = 1655) . Microsoft Dynamics™ GP
provides a facility for editing the launch file from the Tools->Setup->System->Edit Launch file menu. The
Microsoft Dynamics™ GP Help Topic from this window describes how to remove a product from the Launch
File using a text editor.

In order to Completely remove Forms Printer and the Components that it installed, one should remove it
from the Launch file, then remove the runtime components using Windows Programs and Features
Control Panel Applet, Then optionally delete the FPD123.DIC Forms Printer Dictionary, and optionally Drop
the ASI123* Tables and stored procedures in the Microsoft Dynamics™ GP Company SQL Databases.

Adding Roles and Tasks

With the new Security model implemented in Microsoft Dynamics™ GP 10 and greater, it becomes
necessary to enable logins to use or administer Forms Printer by placing the users in Dynamics GP Roles.
These Roles are made of Dynamics GP Tasks that allow access to various programs and code resources.

Roles
When Forms Printer Is initialized and logged into the first time, by ‘sa’ or ‘DYNSA’, The Following Tasks and

Roles are created:

FORMS PRINTER (CRI) ADMIN
This role allows administration of the “Custom Report Integration” (CRI) settings that Forms Printer uses

to connect the Crystal Reports Reporting Engine to the SQL database.
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FORMS PRINTER OPTIONS ADM
This role allows users to access the Forms Printer Setup window where the setup and administration of

various reports printed by Forms Printer are maintained.

FORMS PRINTER USER

This role is for users all users of Dynamics GP that will be using Forms Printer in any capacity to print
reports. While it currently uses the same settings as the FORMS PRINTER OPTIONS ADM role, it can be
modified as needed to restrict access to setup windows.

sa Fabrikam, Inc. 4{12{2017

Role 1D M ame

Fa MAMNAGER® Fised fSzsets manager -
F& STAKEHOLDER® Fired Sssets stakeholders

FORMS PRINTER [CRI) ADMIN Formz Printer and CRI Administration

FORMS PRINTER OFTIONS ADM Farms Printer &dministration

FORMS PRINTER USER Fuarmz Prirer User

HR GEMERALIST* Human Resources Generalist

HR MAMAGER® Hurman Resources Manager o
HR STaKEHOLDER* Human Resources Stakeholder

IT OPERATIOMNS MAMAGER* IT Operations Manager

LEAD GEMERATION Lead Generation

MFG ADMIM= Marnufacturing Adrministratar

MFG_IMQUIRY™= Manufacturing Feporting and [nguiry -
p e Select I Cancel

All GP users who need to use Forms Printer should have at least the FORMS PRINTER USER Role added to
their user security role list. If all users need access to Forms Printer printing, one can add the Forms Printer
Security Tasks directly to a broadly applicable role which many users already have been placed in, such as
“ORDER PROCESSOR”.

Example: Adding the Forms Printer Administrator/User Tasks to the General “Order Processor” Role add
the Security Task ID’s for the Setup Windows, and Forms Printer Options Windows:
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M Security Role Setup

File Edit Tools Help Debug sa Fabrikam, Inc.

I save | & Cear |X Delete |53 Co |

Fiole ID: ORDER PROCESSOR* 4

FRole Name: Order Processor

Role Description: Tasks include verifying that there is sufficient inventary for an order, se
b u - Mark Al Ugmak Al |
Security Task D+ Mame -
[] apmin_FIn_REDO3* Revenue Expense Deferal tables =
IZ‘ ADMIN_FP_CRI_01 Set up Custom Report Integration

ADMIN_FP_CRI_02 Set up Forms Printer Reports/Delivery Cptions

D ADMIN_FS5_005* Field Service Tables

[ apmm_Fss_caoi* Set up Contract Admin

D ADMIN_FS5_CLO1* Set up Service Call Mgmt

[ apmm_Fss_oro1= Set up Depot Mgmt

D ADMIN_FS5_PVO1* Set up Preventive Maintenance

I:I| ADMIN_FSS_RTO1* Setup Returns Mgmt , _'Ll
1 3

IR

Tasks
The Task ID’s above, can be duplicated, and then modified, if you need to apply finer grained control to

users with regards to what Forms Printer related windows they can open. The Default Security Task ID’s
for Forms Printer are defined as shown below:

B Security Task Setup

File Edit Tools Additional Help Debug sa Fabrikam, Inc.

&l Save | £ Cea | X Delete 3 Copy |
Task D ADMIN_FF_CRI_01 |24 cateaom Company -

Task Name Set up Custormn Report Integration
Task Description Set up CRI Settings for Crystal Report SOL Connections
Product: Custom Report Integration -
Type: i -
Series: Company -
Mark &1 | Urimark All
Arcess List

ations__~ |
[ as1 sqL Utiities

[ ast user Activity

D Crystal Test Window

Report Integration Setup

[ sample CRI Integration

Print Operation Access
[CIE

Also: See the specific added window Operations under the ADMIN_FP_CRI_01 Task ID for the System
series.
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Fle Edit Tools Additional Help Debug
I Save | £ Clear | X Delets |5y Copy |
Task ID ADMIN_FP_CRI_02 B Campary -

Task Mame Set up Forms Printer Reports/D elivery Options
Task Description Set up Compary and Peraster Record Settings for Froms Printer Reports

Product: Forms Printer -
Type: “windows =
Series: Campary -

Mark Al | Upmark &l

Operations = |
E Accountable Software Registration

[1 as1 561 Utities

[ AT User Activity

AST_Login

Forms Printer Master Record Setup

Farms Printer Setup - Company Specific

Access List

Fiint Operation Access
44 F M 7

Also: See the specific added window Operations under the ADMIN_FP_CRI_02 Task ID for the Purchasing,
Sales, and System series.

Enter Report Engine Setup Information

From the Forms Printer Setup window or the Forms Printer Plus Setup window, the Report Engine Setup
menu option includes two listings: Crystal Reports Setup, and SQL Server Reporting Services Setup. Report
Engine refers to the reporting tool used to print reports from Forms Printer. Select the Reporting Engine
you wish to setup.

Note: You may use both the Crystal and SRS Reporting Engines with different reports setup to use either
engine.

Window Navigation

To open the Report Engine Setup window, you must first Open the Forms Printer Setup window or the
Forms Printer Plus Setup window using the menu navigation: Microsoft Dynamics GP > Tools > Setup >
Company > Forms Printer or Forms Printer Plus

On the Setup window, select Report Engine Setup then either Crystal Reports Setup, or SQL Server
Reporting Services Setup.

This screenshot shows the Report Engine menu from the Forms Printer Setup window.
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™™ Forms Printer Setup
] Save| ) New| ¢ Delete | - ReportEngine Setup

Crystal Reports Setup

SQL Server Reporting Services Setup |

Crystal Reports Setup
Press this button to open the Report Integration Setup Window where the Report Authentication for

Crystal Reports can be specified.

Window Buttons
The buttons on the SQL Server Reporting Services Setup Window include:

Buttons Description
Save Saves the current entry values and closes the Window.
Window Fields
Fields Description

Manually enter a SQL login and password  Mark this checkbox to enter a SQL Server user and password.

SQL User Name Enter a valid SQL login.
SQL Password Enter the password for the SQL User
Verify Password Verify the password by entering it again.
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Window Example

The screenshot below shows the entries for Crystal Reports using an example SQL

“FormsPrinterUser”.

B Crystal Reports Setup |;|,_ |z|

File  Edit  Tools

H save |

Help  Debug sa Fabrikam, Inc. 4j12/2017

Crystal Reports requires a SOL login and passward.

SOL User Wame

The S0L pazsword entered here MUST have been set uzing SEL management tools.

FormzPrinterl zer|

SOL Pagaword

Werify Pazswaord

SQL Server Reporting Services Setup
Prior to using SQL Reporting Services [SRS] with Forms Printer, you must add SRS setup information. The

use of SRS with Forms Printer is dependent on an installed and properly functioning SRS installation.

Login

Note: Installing Forms Printer DOES NOT affect an existing SRS installation in any way, nor does it

install SRS or any files required to run an SRS installation.

Window Buttons

The buttons on the SQL Server Reporting Services Setup Window include:

Buttons Description
OK Saves the current entry values and closes the Window.
Cancel Closes the window without saving any changes to the
current entry values.
Window Fields
Fields Description

SSRS Report Server URL

SSRS Report Server Web Services
URL

This editable text field is used to enter the path to the
Report Server Web Application.

This editable text field is used to enter the path to the
specific Web Services asmx page in the Reporting
Services Web Applications.
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Window Example
The screenshot below shows these entries for a default installation of Reporting Services on an example

Web Server named “mywebserver”.

B SQL Server Reporting Services Setup

SRS Report Server URL: @)
|http://mywebserver/ ReportServer |

SRS Report Server Web Services URL: @
h&tp://mywebserved’ ReportServer/Report Service 2005.asmx

Note: The SRS Report Server Web Services URL typically would begin with the same value as the SRS
Report Server URL and it must end with either “ResportService2005.asmx” no matter which
version of SSRS you are using unless you have a SharePoint integrated version, in which case it
should end with “ReportService2006.asmx”.
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Forms Printer Sample Reports

The installation of Forms Printer includes sample reports for Forms Printer Base and Forms Printer for
Project. These reports are found in the Forms Printer subfolder of the Dynamics GP directory on any
machine where Forms Printer has been installed.

There you will see subfolders for Crystal and SSRS Reports and within those folders, a directory with

reports organized by Series.
Additional sample Reports for Forms Printer can be found on our website at:

http://www.accountable.com/Downloads/FormsPrinter/Reports

Note that the sample reports are provided as a reference only so that you have a quick and easy way to
evaluate or demo the product. Changes to, and support of, these reports is subject to normal support
incident policy and Accountable Software makes no claim as the accuracy or supportability of the report

content..
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Forms Printer Setup

Overview

Once the Administrative steps of installing Forms Printer, entering the required Roles and Tasks, and
entering Report Engine information have been completed, the next step is to begin the set up Forms
Printer Base System and / or Forms Printer Plus.

Getting Started with Forms Printer Base and Project

Once the installation of Forms Printer is complete, the next step is to decide which Dynamics GP reports
you want to replace with a Crystal or SSRS report printed by Forms Printer Base System or Project.
Following the steps in this guide you will define the report and all of the options to control the delivery of
the report to file, printer and Email.

Forms Printer Base System and Project Setup
To access the setup information, use the Menu item shown in the Window Navigation section, or add the

Forms Printer Setup window to your work button or Shortcut Bar.

Window Buttons

Buttons Description
Save Saves any changes made to window values.
New This button lists choices for adding new entries. The available values vary
depending upon the entry currently selected in the tree view.
Delete Deletes the currently selected entry from the tree view.

Report Engine Setup  Displays the Report Engine Setup menu options for setup of the available
reporting tools.

Window Fields

Fields Description

Report / Company / SOP This treeview list is used to display and modify the list of reports,

Document Type ID / Class Companies, SOP Document Type ID, Class ID, and Master records that are

ID / Master Record List setup to use Forms Printer.

Record Entry Setup Page This editable page is used to determine the various settings for the record
selected in the treeview.
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Window Example
This screenshot shows the Forms Printer window as it will appear prior to adding any report records.

NOTE: If you are upgrading Forms Printer, all of the reports you had setup in your earlier version will be
migrated to the new setup and you will see your settings listed here.

B Forms Printer Setup E]@

E Save| %3 New| ¥ Delete | 3 ReportEngine Setup |

Report Record
Company Entry
Master Record Setup
List Page

Settings Applied To |

Report / Company / SOP Document Type ID / Class ID / Master Record List
The list of reports, Companies, SOP Document Type IDs, Class IDs and Master Records which will be

controlled by Forms Printer are displayed in the treeview. Upon installation and prior to the first added
Report, this list is blank.

Once you’ve added a report for printing with Forms Printer, you can then add one or more Companies
beneath the report entry if different settings per company are desired.

Finally, once a Company has been added, you can add one or more SOP Document Type IDs, Class IDs or
Master Records beneath the Company allowing a Type ID, Class or Master record to have specific settings
for report or delivery.
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To begin adding reports, follow these steps:
1. Click the New button from the control area.
2. Select Include New Report from the dropdown menu.
3. From the Include New Report window, select a Product.
The Product is the Dynamics GP module or 3™ party containing the report to be added.
4. Select the Series.
The Series is the Dynamics GP series containing the report to be added.
5. Select the Report from the dropdown list.
The Report drop down list is the Dynamics GP reports available.
6. Click Save.

The screenshot below shows the Include a New Report window.

B Include a New Report
| Save | € Cancel

Product Microsoft Dynamics GP % |

Series Sales l ‘

Report SOP Orders Blank Paper Unposted ¥ ‘

To add a Company, follow these steps:

NOTE: Only Add Companies if you want DIFFERENT settings between companies, SOP Document Type
IDs, Class IDs or Master Records. If all Companies, SOP Document Type IDs, Class IDs or Master
Records will use the same report and settings, you do not need to add Company Records.

Select a Report in the Report / Company / Class ID / Master Record List.

Click the New button from the control area (or right click in the treeview).

Select Include New Company for Selected Report from the dropdown menu.

From the Include a New Company window, select a Company from the dropdown list.
Click Save.

ukhwnN R

This screenshot of the Include a New Company window shows an example of the Product, Series, and
report fields as well as the selected Company to be added.
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B Include a New Compan
y
EH Save i ° Cancel

Product YMinosoft Dynamics GP
Series |Sales

Report 1Blank Invoice Form

Company | TN - |

To add a SOP Document Type ID Record, follow these steps:
NOTE: Only add SOP Document Type ID records if you want DIFFERENT settings between Type IDs. If all

6.

Type ID Records will use the same report and settings, you do not need to add Type ID Record
entries. If you have a Type ID, a Class ID, or a Customer defined in Setup, the Customer’s settings
will take precedence over the Class ID. Both Customer and Class ID will take precedence over the
Type ID.

Select a Company in the Report / Company / SOP Document Type ID / Class ID / Master Record
List.

Click the New button from the control area (or right click in the treeview).

Select Include New SOP Documents Type ID Record for Selected Report and Company from the
menu.

From the Include a New Document Type ID window, select a Type ID by clicking on the Type ID
Lookup.

This will open a lookup window where you can select a Type ID and return it to the Include a New
Type ID window.

Click Save.

This screenshot of the Include a New Document Type ID window shows the selected report and Company
to which the Type ID is being added.

L:i] Include a New Document Type I S—_—1"—"—— E@g
EH Save | ° Cancel |
Product Microsoft Dynamics GP
Series Sales
Report S0P Fulfillment Order Blank Paper Unposted
Company |Fabrikam, Inc.
TypelD | &y
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To add a Class ID Record, follow these steps:

NOTE:

12.

Only Add Class ID Records if you want DIFFERENT settings between Class IDs. If all Class ID
Records will use the same report and settings, you do not need to add Class ID Record entries. If
you have a SOP Document Type ID and/or Class ID and a customer In that Class ID defined in
Setup, the Customer’s settings will take precedence over the Class and the SOP Document Type
ID.

Select a Company in the Report / Company / Class ID / Master Record List.
Click the New button from the control area (or right click in the treeview).
Select Include New Class ID Record for Selected Report and Company from the menu.

. From the Include a New Class ID window, select a Class ID by clicking on the Class ID Lookup.
. This will open a lookup window where you can select a Class ID and return it to the Include a New

Class ID window.
Click Save.

This screenshot of the Include a New Class ID window shows the selected report and Company to which

the Class ID is being added.

[53] Include a New Class ID (= | B [
E Save] @ Cancel |

Product %Microsoft Dynamics GP
Series  |Sales
Report iSOP Invoices Blank Pzper Unposted

Company %Fabrikam‘ Inc.

ClassID | Q
|

To add a Master Record, follow these steps:

NOTE:

13.
14.
15.
16.

17.

18.

Only Add Master Records if you want DIFFERENT settings between Master Records. If all Master
Records will use the same report and settings, you do not need to add Master Record entries. If
you have a SOP Document Type ID and/or Class ID and a customer In that Class ID defined in
Setup, the Customer’s settings will take precedence over the Class and the Type ID.

Select a Company in the Report / Company / Class ID / Master Record List.

Click the New button from the control area (or right click in the treeview).

Select Include New Master Record for Selected Report and Company from the menu.

From the Include a New Master ID window, select a Master ID by clicking on the Master ID
Lookup.

This will open a lookup window where you can select a Master ID and return it to the Include a
New Master ID window.

Click Save.

This screenshot of the Include a New Master ID window shows the selected report and Company to which
the Master ID is being added.
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B Include a New Master ID
| Save| € Cancel |

Product Microsoft Dynamics GP
Series Sales
Report SOP Invoices Blank Paper Unposted

Company  |Fabrikam, Inc.

Master ID | ADAMPARKD001 [
Adam Park Resort

Record Entry Setup Page
For each of the records added to the Report / Company / SOP Document Type ID / Class ID / Master

Record list, the Record Entry Setup Page is used to determine the individual settings for report engine,
report source, printing and Delivery.

NOTE: When adding a new entry to the Report / Company / SOP Document Type ID / Class ID / Master
Record list each record will, BY DEFAULT, be set to “To Printer’ with number of Copies set to 1.
Also note that all entries must have at least one Delivery Setting either “To File”, “To Printer”, or
“To Mail”.

Window Fields and Controls

Fields Description

Report Tool This dropdown list is used to select the Reporting engine desired for the
selected Report or Company. Note that when choosing Report Writer,
Forms Printer will direct the report to the specified printer. If you do not
want Forms Printer to control the printing, delete the report from Setup.
Choosing Report Writer ONLY enables the To Printer delivery.

Report Path If using Crystal Reports this is filed and lookup are used to select the rpt file
Forms Printer will use.

When using SRS, this field and lookup are used to select the SRS Report,
from the Select Report window of SRS reports.

To Disk File Mark this checkbox to have the report exported to a file each time it is
delivered, regardless of whether ‘File’ was selected as the destination on
the Report Destination window.

File Format The File Format selection determines the format for the exported
document.

Save Folder Determines the directory in which Forms Printer will create the exported
file.

This folder can be determined in one of two ways:
1. Using the Export File Name feature. For details on that functionality
click the link to see the description below.
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Export File Name

To Printer

Print Using

2. Using the Folder Browse Button. This is the path to the directory,
and does not include the file name unless the Export File Name
feature is used to create a file name. Otherwise, Forms Printer
automatically names the file to ensure a unique file name is created.
When printing single documents, the file is named with the
convention: Document Type Document Number System Date System
Time.extension

For Example: Order ORD0001 06-25-01 8 30 27AM.PDF

When printing batches or ranges of documents, the file is named
with the convention: Document Type First Document Number to Last
Document Number System Date System Time.extension

For Example: Order ORD0O001 to ORDO005 06-25-01 8 30 27AM.PDF

The exception to this convention is Statements. Because Statements
do not have a document number, the naming convention is:
Document Type Customer Number System Date System
Time.extension

Or

Document Type First Customer Number to Last Customer Number
System Date System Time.extension

Note: If the document being exported has any custom master
record settings, for ANY master record, then Forms Printer will
create individual files per document, even when printing batches or
ranges.

This window, opened from the Forms Printer Setup window, allows the
building of the Export Directory and Export File Name when using the To
Disk File feature of the Forms Printer Delivery System.

Selecting the ‘To Printer’ checkbox enables the Delivery System printer
output. By default this option is checked. Marking this option will send a
copy of the report to the printer whenever the delivery system is used. Left
unmarked, the report will only print to the printer if the ‘Print’ option is
selected on the Report Destination Window.

Print Using determines where the document will be printed when used
within Microsoft Dynamics™ GP. The valid choices are described below.

Printer Saved On Report — Crystal Reports ONLY

This setting will direct the Crystal report to the printer saved in the
Crystal Report Designer Print Setup window when the report was
designed or modified. If the report has no defined printer or the
defined printer is not available from the workstation, the default
system printer will be used.

Default System Printer
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Copies To Print

To Mail

Use Outlook

Use Crystal MAPI

This setting instructs Forms Printer to print the selected Crystal
report to the default printer defined on the user’s workstation.

Ask Each Time Report Prints

This setting will allow you to select the printer at the time the
report is printed. Using this setting will direct the report to the
selection made during the printing process.

Number of copies determines the quantity output to the printer when the
report is printed. This quantity will override any quantity selected from the
print dialog within the report print setup, or the system default print setup.
If using ‘Ask Each Time Report Prints’, then the number of copies entered in
the properties window will be used.

Note: If the ‘To Printer’ checkbox is selected for a Report or Company, a
copy of the document will be printed every time the Delivery
System is used. To have the document print to the printer only
when specified, mark the ‘To Printer’ checkbox, set the desired
‘Print Using’ and ‘Number of Copies’ options, then unmark the ‘To
Printer’ checkbox. This will allow Forms Printer to use your printer
settings, but only print to the printer when ‘Printer or Delivery
System’ is selected from the Report Destination window, and
Printer is selected from the Delivery System Dialog window. Note
that this functionality DOES NOT apply to Master Records.

Number of copies can also be set using the optional Print Dialog window.
When printing, Forms Printer reads the Microsoft Dynamics™ GP
‘NoPrintDialogs’ setting in the Dex.ini file. If NoPrintDialogs=FALSE, then the
user will be presented with the Print Dialog window. This can be overridden
for Forms Printer Reports only, by using the ASINoPrintDialogs=TRUE dex.ini
setting. The Dialog window allows Number Of Copies and Collate options to
be entered, as well as page ranges when used with Crystal 9 runtime, or
displays a complete printer selection dialog with the Currently installed
Crystal XI-R2 Runtime.

Selecting the ‘To Mail’ checkbox, allows delivery of the selected document
by Email.

Forms Printer will automatically detect whether Microsoft Outlook is
installed, and enable or disable the Microsoft Outlook Radio button and
some of the Email options accordingly.

Note: If using SRS as the Reporting Engine only Use Outlook is enabled.

If Outlook is not detected and the Reporting engine is Crystal Reports, then
Forms Printer will use the Crystal Reports MAPI mailing functionality, and
automatically mark the Crystal MAPI Radio button, disabling the option to
use Microsoft Outlook. Even if Outlook is installed, you may still choose to
use Crystal MAPI Mail by selecting the Crystal MAPI Radio button.

Because of the limits of the Crystal API, certain functionality is unavailable
when not using Outlook.
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The functional limits when using Crystal MAPI functionality are:

1.

2.

3.

You cannot specify an ‘Email From’ profile.
The default profile will be used as the ‘From’ address.
You cannot name the attachment.
The attachment name will be the same as the Crystal
Report used to create it.
You cannot specify the Send Option.
The Email will be sent automatically to the recipient.

Multiple Documents per E- When printing a batch or range of documents with Forms Printer the
Multiple Documents per E-mail checkbox creates a single Email for each
unique mail To E-mail address with all documents for the associated contact
added as attachments to that single Email.

mail

Mail From

Mail To

Send Option

The ‘Email From’ dropdown list will be enabled if Microsoft Outlook is
installed. This dropdown list is populated by default from the Outlook
Global Address List. Here you have the option to use the default Outlook
User, or specify a specific profile to use as the ‘Send On Behalf Of mail
‘From’. If using a profile other than default user, the default user must have
‘Delegate’ permissions in Outlook. For more information about this topic,
please see the Outlook help documentation regarding Delegates.

Note:

In order to use the ‘To Mail’ feature of the Forms Printer Delivery
System, the client workstation must have a Messaging Application
Programming Interface (MAPI) compliant Email application loaded.
The full version of Microsoft Outlook is currently the only supported
MAPI client According to the Crystal /Business Objects/SAP web
site.

To have access to all of Forms Printer’s Emailing functionality, it is
recommended to use Microsoft Outlook 2000 or Greater.

The ‘Email To’ dropdown list allows you to select the Master Record
Address from which Forms Printer will retrieve the Email To Address. This
Email address is stored per Master Record, per Address, in the Internet
Information window. The Master record is either the Customer or Vendor
for which the document was created, depending on the document type
being printed.

Alternatively, the option Scripted Mail To List can be selected allowing the
results of the Scripted Mail To Addresses list to control the Email To
address for the selected entry.

The Send Option dropdown list allows you to select the destination for the
created Email. The selections for Send Options are described below.

Send Directly to Email Recipient: Automatically sends the Email.
Save To Outlook Drafts folder: Creates the Email in the Drafts folder.
Email must be sent manually.

Save to Outlook Outbox: Creates the Email and saves it to the
Outbox. Email must be sent manually.

Save to Outlook Outbox Delayed: Creates the Email and saves it to
the Outbox. Email will be sent automatically at the specified time
selected by the Hours to Delay option.

Display created Email: Creates the Email displays the Email rather
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Hours To Delay

If No Email Address

Printer

Additional Mail To

Addresses

Scripted Mail to Addresses

Additional Attachments

Attachment Format

Attachment Name

Body Text

Message
Subject Text

than sending or saving it. Once any required modifications are
made, the Email can be modified and then saved or sent manually.

The Hours to delay option is enabled when the Send Option dropdown list is
set to ‘Save to Outlook Outbox Delayed’. Setting this number adds the
specified number of hours to the current system time, and uses that to set
the Email’s delayed send property. For example, if the Email was created at
10:15 AM, and the Send option was set to Save To Outlook Outbox delayed,
with an Hours To Delay setting of 12, the Email would be created in the
Outbox, and would stay there until 10:15 PM, and then it would be Emailed
to the selected Recipients.

This dropdown allows you to define the default behavior to follow when the
Master Record does not have a defined Email address in the field(s) defined
by the Email To setup. The choices are either to generate the Email and save
the created Email without an Email Mil To address in the Outlook Drafts
Folder or to print the Document.

The Printer selection is used when the If No Email Address selection is set to
Specific Printer.

The Additional Addresses link opens the Additional Addresses Setup
window. This window allows you to define addresses to mail to, other than
the primary address selected in the ‘Email To’ dropdown list.

The Scripted Mail To Addresses link opens the Scripted Email List window.
This window allows you to manually add a SQL script which returns a
custom list of Mail To, CC and / or Bcc Email Addresses for email delivery.

The Additional Attachments Link opens the Include Additional Attachments
window were files can be chosen as attachments to the Email in addition to
the Dynamics GP document. For help with using the Additional Attachments
window, see the Additional Attachments window section below.

The Attachment Format dropdown list allows you to specify the format for
the Email attachment.

The Attachment Name allows you to enter the text, as it will appear in the
Email for the attachment name. To create a calculated Attachment Name,
open the Subject and Attachment Name Editor window using the expansion
button. When creating an attachment name, the following characters
should be avoided, as they are invalid in the name of a file:
\/?*:“<> |

For help with using the Subject and Attachment Name Editor, see the
Message Editor section below.

This field displays the Message ID to be used when Emailing the selected
document type. For more information, see the Message Editor section of
this document.

This field displays the Message Description.
Email Subject sets the text, as it will appear in the Email Subject line. To
create a calculated subject, open the Subject and Attachment Name Editor

window using the expansion button. For help with using the Subject and
Attachment Name Editor, see the Message Editor section below.
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Window Example
Below is a screenshot example of the Forms Printer Setup window showing SOP Document Type ID,

Customer and Class ID entries in the Report / Company / SOP Document Type ID / Class ID / Master

Record list and Record Entry Setup Page.

o]
H see| iy

New | % Delete | & ReportEngine Setup |

- Microsoft Dynamics GP
-] Purchasing
- Sales
[Z] Blank Packing Slip
[£] RM Statement Long Form
[Z] RM Statement On Blank Paper
[E] RM Statement Short Form
=-=] SOP Invoices Blank Paper Unposted
=@ Fabrikam, Inc.
E]@ Customer Classes

Customers

‘.. B Advanced Paper Co. - Al
=-{C=) SOP Document Type 1D

<

Report Tool Crystal Reports

Report Path IC:\Program Files {x86)\Microsoft Dynamics\GP2010\Forms Printer\Crystal

Deliver this report using the options
[T] To Disk File
File Format
Save Folder

[] To Printer

Print Using Copies to Print 1

v

Default System Printer

l

(® Use Outlook  (©) Use Crystal MAPI
Default Outlook User

Master Primary

Specific Printer

Printer

[2]

[] Multiple Documents per E-mail

v

To Mail
Mail From
Mail To
Send Option
If No Email Address

v

Hours to Delay 0

Microsoft XPS Document Writer

Scripted Mail to Addresses

Adobe PDF
test
test

Printer

Additional Mail to Addresses
Attachment Format
Attachment Name
Body Text

Message
Subject Text

Additional Attachments

vl

Qls]

test

Settings Applied To | Customer
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Select File Name

The Select File Name window is used to create a custom file path and or file name for use when exporting
to file through the delivery system. This feature allows the folder and / or file name to be created at
runtime based on data associated with the document. For example, rather than defaulting the file name
to the Forms Printer naming convention of Document Type, number and date time, you could create a file
that gets its file name from each Purchase Order’s PO Number. In the screenshot below a file will be
created for each Purchase Order as it is printed, and the name of the file will be the PO Number of the
transaction. Note the parameter used to create the file name. All fields associated with the document are
accessible for the parameterized name and are listed in the Select Form Fields list.

[ogl Select File Name SRRCRL X"
File Edit Tools Help Debug sa Fabrikam, Inc. 4/12/2017
@ ok |[[3] Clea
Select Form Fields: Select System Fields: Select Global Fields:

w-EH Invoicing Transaction Work} [ B Company Location Master [ +-E2{ System Fields
M Customer MSTR +)-E Users Master
- Comment Master

3 SelectFile |

When creating the file path, there are several rules that Forms Printer will follow. Those are:

1. If the created file path and name do not contain a period “.” After the last backslash “\”, Forms
Printer assumes you are trying to define only a file path and NOT a path and name. It will look for
the path as defined and, if found, will create a file using the standard naming as detailed in the
Save Folder description in the table above. For example, the folder path below would assume that
no file name has been added because there is no period. Forms Printer would expect there to be a
folder with the PO Number as its name.

ONLY FOLDER DEFINED: n:\myreportfolder\{<RF>'PO Number’ of table POP_PO,0}
In this example, the entire folder path and file name are defined:
FOLDER AND FILE NAME: n:\myreportfolder\{<RF>'PO Number’ of table POP_PO,0}.pdf

2. The defined folder path MUST exist and be a valid path from the printing workstation. Forms
Printer will not try to create the folder path at runtime. If the folder does not exist, documents
defined to go to that folder will fail and must be reprinted.
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3. Any part of the file / folder name can be parameterized but when parameterizing the folder path,
remember rule #2.

4. The file extension defined must match the extension selected in the File Format dropdown on the
Forms Printer Setup window. If they do not match, the name of the file will be as specified here in

the Select File Name window but that actual file format will be that of the File Format dropdown
selection.

5. If a duplicate file name is created as a result of exporting to file, Forms Printer will overwrite the
existing file WITHOUT WARNING.

Additional Email Addresses Setup

The Additional Addresses button opens the Additional Addresses Setup window. This button also provides
a visual indicator as to whether or not additional addresses have been entered. If additional addresses
exist for this document type, the button will be displayed in yellow. When no additional addresses exist,
the button will be white. This window allows you to define addresses to mail to, other than the primary
address selected in the ‘Email To’ dropdown list. The screenshot below shows this window.

B Additional E Mail Address Setup
File Edit Tools Help Debug

EH Save | X Delete |

: Mail Aadréss Type B 7 ﬁegﬁi}ed ‘ Usé E Mail A&d;;ass Df
Mail To Address 1| 0] _|Document Bill To

\CC Address v Document Ship To
|BCC Address ¥ Document Salesperson
|
[ il il
— Manually Add Additional Addresses

EMailToList | sales@accountable.com; techsupport@accountable.com
EMalCClist |1
E Mail BCC List

Mail Address Type

Determines whether the selected address will be added to the Email To, Cc, or Bcc list of the Email.

Required

Mark this checkbox to have the Email halted when the selected address is blank. If using Crystal MAPI for
Emailing, the Email will not be created if the Primary or any Required Email Address is blank. If using
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Outlook, the Email will be created, however the ‘Send Option’ will be ignored, and the Email will be saved
as a Draft. In either case, the error will be reported on the Delivery System Error Log, which prints after an
Emailing error is encountered.

Use Email Address Of

The ‘Email Address Of dropdown list allows you to select the Master Record Address from which Forms
Printer will retrieve the additional Email Address. This Email address is stored per Master Record, per
Address, in the Internet Information window. The Master record is either the Customer or Vendor for
which the document was created, depending on the document type being printed.

Email CC List
The Email CC List allows you to manually enter additional addresses to be Carbon Copied.

Email BCC List
The Email CC List allows you to manually enter additional addresses to be Carbon Copied.

**Note: Email Addresses in the CC and BCC lists must be separated with a Semi-Colon. If you enter a
combination of manual addresses and dynamically selected addresses, Forms Printer will use both to
create a complete Email To, Cc and Bcc list.
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Scripted Email List

The Scripted Mail to Addresses button opens the Scripted Email List window. This window allows you to
manually add a SQL script which returns a custom list of Mail To, CC and / or Bcc Email Addresses for email
delivery.

|- 4 Scripted Email List -0l x|
File Edit Tools Help sa Fabrikam, Inc. 4/12/2017
I Save | & Clear | X Delete

Select Form Fields: Select System Fields: Select Global Fields:
&£ RM Customer MSTR B Company Location Master & System Fields
- Sales Transaction Work & £ Users Master

&-E# Sales User-Defined Work His
Fé g Comment Master

£ [ —
3 Browse Data

SELECT =
[INET1]AS MAIL_TO,
[INETE] 45 CC_TD,

[INET7] 45 BCE_TO

FROM
[Tw0][dbo].[5Y01200]
‘wHERE
[INET1] <> " AND {<RF>'Customer Number' of table RM_Customer_MSTR,0} = Master_ID

Select Form Fields
The Select Form Fields List displays the form tables and fields available to be used as parameters for the
selected document type. Double clicking on a field adds that field to the script text.

Select System Fields
The Select System Fields List displays system tables and fields available to be used as parameters for the
selected document type. Double clicking on a field adds that field to the script text.

Select Global Fields
The Select Global Fields List displays global fields available to be used as parameters for the selected
document type. Double clicking on a field adds that field to the script text.

Browse Data
The Browse Data button displays a list of the first 5 unique values in the selected Form Table column. This
is provided as an easy way to determine the contents of a given field.

Script Input
The Script Input field allows the user to enter a valid SQL script. Supported syntax includes SELECT AND
EXEC statements for SQL Tables, SQL Views, SQL Functions and Stored Procedures.
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Script Help
The Script Help button opens the Scripted Email Help window which displays a basic explanation on the
use of the Scripted Email feature.

Test
The Test Button opens the Scripted Email Query Test window where the entered script can be tested for
syntax and proper data return based on entered parameters.

Scripted Email Query Test

The Scripted Email Query Test window verifies the script entered on the Scripted Email List window. Any
error in the Script’s syntax, references or parameters will be displayed by a dialog box once the Run Query
button is pressed.

- 4 Scripted Email Query Test M[=1£3
File Edit Tools Help sa Fabrikam, Inc. 4/12/2017
Parameter Name: Parameter Value:

Customer Number ASRONFITODO1 -

Results:

Maill To: ‘afit@afe.comwarehouse@fitz.com’ -
CC To: 'sales@afitz.com;sales@afitz.com’
BCC To: 'sales@fabricam.com;sales@fabricam.com'

[« | i

Parameter Name
The Parameter name list shows parameters created by the entered script.

Parameter Value
The Parameter Value list allows you to enter values for each of the Parameter in the script allow you to
test the results for one or more records as needed.

Run Query
The Run Query Button executes the entered script passing to the script any entered parameters.
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Results
The results pane shows the returned data from the execution of the query. The data is listed in the form of
the returnable fields:

Mail To:
Displays a semicolon separated list of the Email To Email addresses returned by the script.

CCTo:
Displays a semicolon separated list of the CC To Email addresses returned by the script.

BCC To:
Displays a semicolon separated list of the BCC To Email addresses returned by the script.

Important Notes on Scripted Email Lists

1. The Scripted Email Lists can return 1 or more email addresses for the Email To, CC and BCC fields.
When the script finds more than 1 record matching the selection formula, the records will be

returned in a semicolon separated list.

BE CAUTIOUS WHEN ENTERING YOUR SCRIPT.YOU ARE RESPOSIBLE FOR ENSURING THE PROPER
SCRIPT AND SELECTION CRITERIA HAVE BEEN ENTERED. THE WRONG SCRIPT CAN SEND EMAILS
TO INDIVIDUALS YOU DID NOT INTEND.

2. You can choose to use any or all of these 3 but the order is always fixed. In other words, the
returned result will always be Email To, then CC, then BCC lists. If you wish to skip one or more of
the lists, return a blank column from the script by using empty quotes. For example, if we wanted
to return the Email To and BCC but not the CC we would enter

SELECT Fieldl AS MailTo, ‘' AS CC, Field3 AS BCC..

3. The context of the script execution is based on the current Dynamics GP company. If you need to
execute the script in the context of a different database, you may add the database and owner
descriptors. For example, to execute a script in the Dynamics database you would use the syntax:

SELECT Fieldl FROM DYNAMICS.dbo.TableX

4. The Scripted lists can be used exclusively or in conjunction with the Email To functionality and
Additional Mail To Addresses functionality available on the Forms Printer Setup Window.

To have the scripted List completely control all of the Email addresses, select the Scripted Mail to List

option from the Email To dropdown list on the Forms Printer Setup window and leave the Additional Mail
to Addresses blank.
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Additional Attachments

The Additional Attachments window allows files to be selected for attachment to the Email when a
Dynamics GP document is being delivered To Mail. These files can be selected by name or they can be
included using hardcoded text and parameter fields from specific tables, system tables, and global fields.
When the Email is created Forms Printer will fill in any parameters using data associated with the
document being Emailed, retrieve the file from the file system and attach it to the email along with the
Dynamic GP document before completing the defined delivery.

Note: If the defined document(s) does not exist at the time the email is generated, Forms Printer WILL
STILL CONTINUE WITH DELIVERY. Failure to retrieve a defined file DOES NOT STOP the Email. To stop the
email and display an error, set the Dex.ini entry ASIFP_ERRORONMISSINGATTACHMENT = TRUE.

The screenshot below shows an example of a list of files to be added as attachments to the delivered
Email.

r — —~ .
|-l Include Additional Atttachments * ol |
—

EH Ssave ° Cancel

Product Microsoft Dynamics GP

Series Sales

Report SOP Orders Blank Paper Unposted
Compary

Master |0

C:\Files'\Test xdsx
C:\Files\{<RF+Customer Number' of table RM_Customer_MSTR.0} bt
C:\Files'\New Folder'”*

Add

The Add button opens the Attachment Path and File Name window where files can be selected and
paths containing report fields can be built.

Edit
The Edit button opens the Attachment Path and File Name window, displaying the file and path

highlighted on the Include Additional Attachments window. From there you can make changes to
the file name and path by making manual changes or by selecting a new file.

Delete

The Delete button removes the highlighted file from the list of attached documents.
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Select File Name
The Select File Name window allows you to type in, select or build a path and file name for the

file(s) to be attached. When building the path or name using parameter fields, any part of the file
name or path can be replaced with the parameter.

The screenshot below shows an example of the Select File Name window.

\;; Select File Name A st

File Edit Tools Help Debug sa Fabrikam, Inc. 4/12/2017
@ ok |[5] Clea

Select Form Fields: Select System Fields: Select Global Fields:

- Invoicing Transaction Work | | @-EH Company Location Master | | - System Fields
RM Customer MSTR (#)-fd Users Master
#-E Comment Master

E3 SelectFile

Select File
The Select File button open the Select a File window where you can browse local files, network folder and
UNC paths to find and select a file to be added as an attachment to your Email.

Select Form Fields
The Select Form Fields List displays the form tables and fields available to be used as parameters for the
selected document type. Double clicking on a field adds that field to the file path and / or name.

Select System Fields
The Select System Fields List displays system tables and fields available to be used as parameters for the
selected document type. Double clicking on a field adds that field to the file path and / or name.

Select Global Fields
The Select Global Fields List displays global fields available to be used as parameters for the selected
document type. Double clicking on a field adds that field to the file path and / or name.

Note: Parameters appear in the Path and File Name surrounded by {}. These brackets and all of the text
that appears between them are required in order for Forms Printer to pull the correct
information. The parameters shown in the path will be replaced with the actual value of the
fields when the Email is created. These parameters should not be altered in any way.

Message Editor
The Message Editor Window is used to create the Email message or body for the document type to which
it is assigned. This message can be manually entered text, or a combination of manually entered text and
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parameter fields added from specific report tables, system tables, and global fields. When the message is
created and assigned to a particular document, Forms Printer will fill in any parameters using data
associated with the document being Emailed.

The screenshot below shows an example of a parameterized message for an unposted Sales Order
Processing document.

m Message Editor Q@@
Fle Edit Tools Help Debug sa Fabrikam, Inc. 4/12/2017
K save | & Cear |
Message ID | TESTID &
Message Description | Test
Select Fom Fields: Select System Fields: Select Global Fields:
2=, Batch Number N =l City A | @ B systemFieids
= Customer Number =/ County
=] Customer Name - =] State
2= Customer PO Number 2= Zip Code
2=| Prospect =| Country
2=| Master Number 2= Phone 1 |
22! Packing Slip Number 2= Phone 2 |
i | > =l Phone 3 v
3 Browse Data
Dear {<RF>'Contact Person’ of table SOP_HDR_WORK.0} , Al

Atached please find the invoice foryour PO Number {<RF> Customer PO Number'of table SOP_HDR_WORKD} . |
If you have any questions regarding this invaice please contact us at 484.875.0600.

1<SF>'User Name' of table SY_Users_MSTR.0}

{<SF>'Location Name' of table SY_Location_MSTR,0}

{<SF>'Address 1' of table SY_Location_MSTR.0}

1<SF>'City of table SY_Location_ MSTR.0} , 1<SF>'State’ of table SY_Location_MSTR.0} {<SF>Zip Code' of table SY_L.

Note: Parameters appear in the Message Editor Text field surrounded by {}. These brackets and all of
the text that appears between them are required in order for Forms Printer to pull the correct
information. The parameters shown in the message will be replaced with the actual value of the
fields when the Email is created. These parameters should not be altered in any way.

Select Form Fields
The Select Form Fields List displays the form tables and fields available to be used as parameters for the
selected document type. Double clicking on a field adds that field to the message text.

Select System Fields
The Select System Fields List displays system tables and fields available to be used as parameters for the
selected document type. Double clicking on a field adds that field to the message text.

Select Global Fields
The Select Global Fields List displays global fields available to be used as parameters for the selected
document type. Double clicking on a field adds that field to the message text.

Browse Data

The Browse Data button displays a list of the first 5 unique values in the selected Form Table column. This
is provided as an easy way to determine the contents of a given field.
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Note: Because Message parameters are based on document specific tables, the messages created are
available to be used only by the document group for which they were created. A message
created for a Statement can be used as the message when Emailing statements. A message
created for unposted Sales Transactions, however, can be used for all unposted Quotes, Orders,
Invoice, Returns, and Backorders. A Message created for Historical Sales Documents may be used
only for posted Quotes, Orders, Invoice, Returns, and Backorders. Messages for Purchase Orders
may be used only for Purchase Order formats.

Subject and Attachment Name Editor

The Subject and Attachment Name Editor Window is used to create the Email subject and attachment.
This text can be manually entered text, or a combination of manually entered text and parameter fields
added from specific report tables, system tables, and global fields. When the field is created and assigned
to a particular document, Forms Printer will fill in any parameters using data associated with the
document being Emailed.

The screenshot below shows an example of a parameterized subject or attachment.

B Subject and Attachment Name Editor Q@@
Fle Edit Tools Help Debug sa Fabrikam, Inc. 4/12/2017
v 0K | & Cea |
Select Form Fields: Select System Fields: Select Global Fields:
= RM Customer MSTR A | | = B Company Location Master A | | @ [ System Fields
= Customer Number o .= Company ID
=, Customer Name =, Location ID
.= Customer Class = Location Name
= Corporate Customer Nu =] Address Code
=] Contact Person ..=| Address Contact
=] Statement Name ] =| Address 1
& E il ] &) =| Address 2 v
) Browse Data
Invoice for {<RF>'Customer Name' of table RM_Customer_MSTR,0} from {<SF>'Location Name' of table
SY_Location_MSTR,0}
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Window Navigation

To open the Forms Printer Setup window, use the following menu path in Dynamics GP:

Microsoft Dynamics GP > Tools > Setup > Company > Forms Printer

The screenshot below shows the menu path.

BENES

User and Company
User Date

Edit

Maintenance

SmartList

pr Reminders

Task List

Process Monitor
User Preferences

Print Setup...

Close All Windows
Exit

4 Microsoft Dynamics GP ~

»

»

Customize this page...

__‘A'l.‘

Utilities >
Routines »
SmartList Builder 3
Extender »
Customize »
Integrate »
Macro »
Resource Descriptions »
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Setup Checklist

System »
Posting >
Workflow Setup

Finandial »
Sales >
Purchasing »
Inventory »
Payroll »
Project »
Human Resources »
Manufacturing »
Fixed Assets »

Company

Account Format
Fiscal Periods

Tax Details

Tax Schedules
Shipping Methods
Payment Terms
Bank

Credit Cards
Comments

Internet Information
Custom Link
Customer/Vendor Setup

Forms Printer

A ns
A Specifiy reports and report option:

Grant Management

s for Forms Printer




Printing Using Forms Printer
Once the Forms Printer Delivery System has been setup, you can print using the normal processes for each

document type. When printing documents with Delivery System Options, you will be presented with the
Report Destination window, with the destination choices of ‘Screen’, ‘Printer or Delivery System’, and
‘File’.

Choosing Screen outputs the document to either the Crystal Reports or SRS Preview window.

Choosing Printer or Delivery System displays the Delivery System Dialog window. The Delivery System
Dialog window allows you to select from ‘Printer’ or ‘Delivery System’.

Choosing Printer disregards the ‘To File’ and ‘To Mail’, as well as all of the Delivery System Master
Record Setup options, and prints the report directly to the printer defined in the Delivery System
Document Setup window.

Choosing Delivery System allows Forms Printer to deliver each document to the destination
defined in either the Delivery System Document Setup window.

Choosing File disregards the Delivery System Document Setup options, and exports the Report to the file
and format selected in the Report Destination window.

When choosing File, the Export Types dropdown list will display all of the available Report export types.
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Forms Printer Plus Setup

Overview

Once the Administrative steps of installing Forms Printer, entering the required Roles and Tasks, and
entering Report Engine information have been completed, the next step is to add Forms Printer Plus
reports.

Note: Crystal Reports added through Forms Printer Plus follow the same “generic” data connection
rules as those used in Forms Printer Base. See the Crystal Report Setup section for details.

Forms Printer Plus Setup Window
The Forms Printer Plus Setup window is used to view and modify previously defined report setups as well

as to launch the Forms Printer Plus Setup Wizard where new reports can be defined.
To access the setup information, use the Menu item:

Microsoft Dynamics GP > Tools > Setup > Company > Forms Printer Plus
or add the Forms Printer Plus Setup window to your work button or Shortcut Bar.

Window Buttons

Buttons Description

Save Saves any changes made to window values.
This button opens the Forms Printer Plus Setup Wizard where a new report
setup can be defined.
Delete Deletes the currently selected report from the tree view.
Displays the Report Engine Setup menu options for setup of the available
Report Engine Setup  reporting tools. Note that this window is shared with Forms Printer and Plus.
If using both products, setup only needs to be done once.

New

Window Fields

Fields Description

Tree view This treeview list is used to display and modify the list of reports that are
setup in Forms Printer Plus. The tree view lists defined reports using the
hierarchy of Product, Series, Form, Company, and Report display name.

Record Entry Setup Page This editable page shows the tabs used to modify the various settings for
the record selected in the treeview.
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Window Example
This screenshot shows the Forms Printer Plus Setup window as it will appear before adding report records.

Ei] Forms Printer Plus Setup EI

B Seve| %y Mew| 3 Delete | 3 Report Engine Setup

This treeview will display
created reports setups

using
Product >
This pane will display the various
Series >
Form > Report Setup Tabs
Company > Used to view and modify created reports setups
Report Display Name

Settings Applied To |

Getting Started with Forms Printer Plus

After following the installation steps for Forms Printer Plus, the next step is to begin deciding on which
window in Dynamics GP you would like to run a report, choosing how the report should be launched,
selecting the report to be run, mapping fields from the window to the report, and deciding on delivery to
file, printer and Email.

To begin this process, launch the Forms Printer Plus Setup Wizard by clicking on the New button on the
Forms Printer Plus Setup window.

Once you have created a report setup, it will appear in the Forms Printer Plus Setup treeview and you will
be able to edit its various options directly in each tab of Forms Printer Plus Setup. For details on the Forms
Printer Plus Setup window tabs, see the section below detailing the Forms Printer Plus Setup Wizard.
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Forms Printer Plus Setup Wizard
The Forms Printer Plus Wizard is used to create new report setups. After launching the wizard from Forms

Printer Plus Setup, you will navigate through each tab, defining the required information on that tab. Once
complete, click the Next button to be taken to the net tab in the sequence.

Each tab includes a brief explanation of the tab’s functionality as well as the same set of basic navigation
buttons defined below.

Wizard Buttons

Button Description
Cancel Closes the Setup wizard without saving the report setup.
Previous Navigates back one tab in the setup process.
Next Navigates to the next tab in the setup process.
After entering all required setup information, this button closes the wizard and
Save creates the new report setup, displayed in the Forms Printer Plus Setup
window.

Welcome Tab
The Welcome tab displays a brief description of the steps that will be performed in the Setup Wizard.

Window Example - Welcome

I;—E] Forms Printer Plus Setup Wizard E’

Welcome |Comparw | Window I Frint Initiation | Report | F, | Delivery Options I Review‘

Welcome to the Forms Printer Plus Setup Wizard.

Start here to assign Crystal Reports or SQL Server Reporting Services Reports to be attached to and run from any window in
Dynamics GP.

Prior to beginning this process, the Report Engine Setup for Crystal Reports and/or SQL Reporting Services must be completed. See the User
Guide for details

To complete the process, the information required includes the window on which the report should run, the process by which the report should
be started, the report which is to be run, and any fields on the window which will be the source of information for parameters on the repart.

<« Prewious Mext 3> Save
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Company Tab
The Company tab is used to define in which company(s) the defined report should be run.

Tab Buttons

Button Description

Companies This radio group is used to determine whether the report setup will be available
in All Companies or within a Specific Company. By default, the setup will be
available in all companies. To define the setup for an individual company, mark
the Specific Company radio option then use the Specific Company list to choose
the company in which the setup will be available.

Tab Fields
Field Description
Select Company This list box, enabled when the Specific Company radio button is selected,

displays the available companies within Dynamics GP. If the report setup
being created is intended to be available in a single company, use this list to
choose the company in which the report will be available.

Window Example - Company

(=5 Forme Printer Pits Setup Wizard = = ==
| Welcome | Company | Window | Print Initiation | Report | P: | Delivery Options [ Review |

Company Selection

Define which companies should run the report.

Ldditional company and report combinations can be defined by going back through the wizard setup.

Companies

@ All Companies () Specific Company
Specific Company | Fabrikam, Inc.

Note: Once a report setup is created and saved using the “All Companies” selection, you will NOT be
able to define a report setup using the Specific Company selection using the same Window and
Button as a setup using the ‘All Companies’ selection. You can define multiple reports for the
same window using the Additional menu or other buttons.
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Window Tab

The Window tab is used to select the window to which the Forms Printer Plus report should be attached.

Tab Buttons

Button

Description

Help Me Choose

Window Lookup

This button puts the wizard into a “Picker” mode that assists the user in
selecting the window on which the report will be available. See the Help Me
Choose Window Picker for details.

This button opens the Window Lookup window allowing the user to manually
select the window on which the report will be available. See the Window
Lookup Window for details.

Tab Fields

Field Description
This display only text fields shows the product in which the window returned by

Product . . .
either the Help Me Choose process or the Window Lookup exists.

Series This display only text fields shows the series of the window returned by either the
Help Me Choose process or the Window Lookup.

Form This display only text fields shows the Form of the window returned by either the
Help Me Choose process or the Window Lookup.

Window This display only text fields shows the window returned by either the Help Me Choose

process or the Window Lookup.

Window Example - Window
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4 Forms Printer Plus Setup Wizard [E=H SR ==

| Welcome | Company | Window | Print Iniiation | Repart | Parameters | Delivery Options | Review |

Window Selection

Define which Window the report should run from.

Selecting the window includes choosing the product and form in which the window exists

Product Microsoft Dynamics GP l Help Me Choose

Seri Financial To use the point and click window picker, click
res Help Me Choose. Then open and dlick on the

Form GL_Inquiry_Cument_Summary desired Dynamics GP window.

Window  GL_Inquiry_Cument_Summary

‘Summary Inquiry Window Lookup

To select the Product, Series. Form and
Window from lists, click Window Lookup.

=




Window Lookup Window

The Window Lookup window, aside from having an awkward name, is used to select the window on which
a Forms Printer Plus report will be available. The selection of the window is made manually on this
window by choosing the source product, series, and form.

Note: If unsure of the Product, Series, Form or window, the Help Me Choose option provides a ‘point
and click’ selector that will identify these elements automatically.

Tab Buttons

Button Description

Select This button closes the Window Lookup window and returns the selected
information to the wizard.

Cancel This button closes the Window Lookup window without returning information to
the wizard.

Tab Fields

Field Description
Product This dropdown list displays a list of products included in the current Dynamics GP
system. Use it to select the product in which the intended window exists.
Series Once the Product is selected, this dropdown lists the series that exist in that product.
Use it to select the series in which the intended.
Once the Series is chosen, this list shows the available forms within the selected series
Forms . . . . .
and product. Use it to select the form on which the intended window exists.
Window Once the Form is selected, this list displays the windows available on the selected

form. Use it to choose the window on which the report should be available.

5§ Window Lookup SE]E=]

File Edit [QEEES Help sa Fabrikam, Inc. 4/12/2017

Product Microsoft Dynamics GP -

Series Financial -

Foims

Techincal Name Display Name &
GL_Account_Category_Maintenance Account Category Setup
GL_Account_Entry Account Entry

GL_Account_Msintenance Account Maintenance a
GL_Account_Segment_Restrictions Account Segment Ranges

GL_Account_Summary Account Summary

GL_Account_Summary_History Account History
GL_Batch_Entry Batch Entry

£1 Duidmet lmevemal Uit |onbn Listoc:Duidoct ool Cotuin

indows

GL_Account_Summary

Page |47



Help Me Choose - Window Picker

The Help Me Choose button puts the wizard into a “Picker mode”. When opened from the Window tab,
this mode is used to click on the window on which the Forms Printer Plus report is to be available. To
choose the GP window using the picker, first click on the Help Me Choose button from the Window tab.
Dynamics GP will be brought to the foreground and Picker mode is indicated by a change in the cursor to
the image shown below:

While in Picker Mode, navigate Dynamics GP through the normal menu selection or other navigation
methods and open the window on which the report is to be attached. Once open, click on the window to
select it and return the window information back to the Forms Printer Plus Window tab.

Below is an example of a Dynamics GP window about to be selected in Picker mode.

- o/ Summary Inquiry E [l
File Edit Tools View Help sa Fabrikam, Inc. 4/12/2017
Clewr % B
Account S P
Description Year m? -
Period Debit Credit Net Chanae Period Balance
Totals
Currency
4 4 » P bydccount Type - O©

Note: You may find that not all fields on the window are selectable with the Picker. If this is the case,
use the Field Lookup window to manually select from a list of available fields.

While in Picker mode, you can cancel and return to the wizard by clicking the Cancel Picker
button on the Window tab.
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Print Initiation Tab

The Print Initiation tab is used to determine the process by which the report will be run. The choice is
made to have the report run from the Additional menu or from a button on the window selected on the
Window tab.

Tab Buttons

Button Description

Help Me Choose This button puts the wizard into a “Picker” mode that assists the user in
selecting the button to be used in launching the report. See the Help Me
Choose Field Picker for details.

Field Lookup This button opens the Field Lookup window allowing the user to manually
select button to be used in launching the report. See the Field Lookup Window
for details.

Tab Fields

Field Description

Product This displays the product containing the selected window.

Window This displays the selected window.

This radio group determines whether the report will be run from the Additional menu

Print From .
or from a button on the window.

This radio button option is the default. When selected, the report will be available

Additi I M
Sdiicnaiens from the window from the Additional menu on the selected window.

Enabled when the Additional Menu radio button is selected, this field is used to enter

Menu Name . .
text as it should appear on the menu when selecting the report to run.

This radio button option is selected when the report is to be run by clicking on a button

Win B n
L[ I on the selected window.

Displayed and enabled when the Window Button radio button is selected, this field
Window Button displays the name of the window button chosen by either the Lookup of Picker
process.

Note: When set to Window Button for the Print From setting, Forms Printer Plus will run the report
defined after the other normal processing defined for the selected button.
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Window Example — Print Initiation

‘ ‘wielcome | Company | findow | PirE Triiahon | Report | F. Delivery Options | Rawewl

Print Initiation Selection

Define the method for launching the report,

The report can be launched from the Additional menu, or from a window button.

Product Project &ccounting

Window  Customer Maintenance

Pirt F
fint Fram Help Me Choose

Additional M “window But To uge the point and click field picker, click
© fonal Menu - © window Bukon Help Me Choose. Then click on the desired
button in the chosen Dynamics G window.

Meru Name

Field Lockup

To select the button from a list available from
the chosen window, click Field Lookup.

Ready.
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Field Lookup Window

The Field Lookup window, when opened from the Print Initiation tab is used to select the button from
which the Forms Printer Plus report will be run. The selection of the button is made manually on this
window by choosing from the list of buttons available on the window chosen on the Window tab.

Note: If unsure of the button, the Help Me Choose option provides a ‘point and click’ selector that will
identify the button by clicking on it.

Picker mode can be canceled at any time by returning to the Forms Printer Plus Setup or Wizard
and clicking the Cancel Picker button shown in place of the Help Me Choose button.

Window Buttons

Button Description

Select This button closes the Field Lookup window and returns the selected information to the
wizard.

Cancel This button closes the Field Lookup window without returning information to the wizard.

Window Fields

Field Description

Form Displays the form name of the selected window.

Window Displays the name of the selected window on which the report will be run.

This checkbox changes which fields are shown in the Fields list. With the box checked,
Include Local Fields all fields created as part of the current form will be shown along with table fields and

window controls, such as buttons, dropdown lists, etc.

This list displays all of the buttons available on the selected window. Choose the
Fields desired button and then click the Select button to close the Field Lookup window and

return the selection to the wizard.

Window Example - Field Lookup ) Field Lookup

File Edit Tools Help Debug

Formn

| RM_Customner_Maintenance |

window

| RM_Customer_Maintenance |

Fields

Field Name Datatype =
(L) Address Profile Button Unknown B
(L) AddressCodes Unknown
(L) AddressReturnFlag Unknown
(L) BillToAddresses Unknown
(L) Check Address Unknown
(L) Check Cancel Unknown
(L) Class Profile Button Unknown
(L) Email Addresses Loaded Unknown
(L) Export Type Unknown
(L) File Export Name Unknown
(L) FillAddressCodes Unknown
(L) FillBillToAddresses Unknown
(L) FillPaymentTerms Unknown
(L) FillShippingMethods Unknown
AN CCinTaA ddonrsan [T Py i
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Help Me Choose - Button Picker

The Help Me Choose button puts the wizard into a “Picker mode”. When opened from the Print Initiation
tab, this mode is used to click on the button from which the Forms Printer Plus report is to be run. To
choose the button using the picker, first click on the Help Me Choose button from the Print Initiation tab.
Dynamics GP will be brought to the foreground. If the window chosen from the Window tab was not
closed, it should be the focused window. If it isn’t, navigate Dynamics GP through the normal menu
selection or other navigation methods and open the window chosen on the Window tab.

Once the window is open, Picker mode will be indicated by a change in the cursor to the image shown
below:

e

Click on the desired window button to select it and return the button information back to the Forms
Printer Plus Print Initiation tab.

Note: In Dynamics GP 2013 R2, a new window ribbon bar was implemented. The Forms Printer Plus
Button Picker WILL NOT recognize buttons on this ribbon. You will need to use the Field Lookup
window and select the print button manually if using the R2 ribbon bar.

Because the window has already been selected in the Window tab, Picker Mode will not allow
any button except those on the selected window to be returned to the wizard.

Picker mode can be canceled at any by returning to the Forms Printer Plus Setup or Wizard and
clicking the Cancel Picker button shown in place of the Help Me Choose button.

You may find that not all fields on the window are selectable with the Picker. If this is the case,
use the Field Lookup window to manually select from a list of available fields.
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Report Tab
The Report tab is used to determine whether the Forms Printer Plus report will be a Crystal or SSRS report.

With that determination made, the path to the Crystal Report or the selection of the published SSRS
report is made.

Tab Buttons

Button Description

Report Lookup This button opens either the Open window to select the physical Crystal report
file or the SSRS report list to select the published SSRS report depending upon
the selection made in the Report Type radio group.

Tab Fields
Field Description
Report Type This radio group is used to select between the available report types: Crystal Reports

or SQL Reporting Services reports.

This default radio option enables the Report Path Lookup button to browse the file

izl system for the physical Crystal Report .rpt file.

This option enables the Report Path Lookup button to open the Select Report window
listing the published SSRS reports.

This text field displays the path / url and name of the report selected by the Report
Lookup button.

SQL Reporting Services

Report Path

Window Example - Report

|- &l Forms Printer Plus Setup Wizard o B[]
| Welcome I Comparny | Window I Print Initiation | Report | B I Delivery Options I Re\ﬂewl
Report Selection
Select the Crystal reportor SQL Server Reporting Services report to be launched.
Report Type
@ Crystal Reports () SQL Reporting Services
Report Path C:hUzers\DefaultDocuments Accounts Summary rpt i@
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Parameters Tab

The Parameters tab is used to display the parameters on the selected report and choose how the values

for those parameters will be supplied. The value passed to the report’s parameters can come from

manually entered values entered by the user at the time the report prints, manually entered input when

the report setup is defined, or from field values on the selected window.

Tab Buttons

Button

Description

Help Me Choose

This button puts the wizard into a “Picker” mode that assists the user in
selecting the button to be used in launching the report. See the Help Me
Choose Field Picker for details.

Field Lookup This button opens the Field Lookup window allowing the user to manually
select button to be used in launching the report. See the Field Lookup Window
for details.

Tab Fields

Field Description

Parameters This field lists each of the parameters found on the report selected on the Report tab.

How parameter values
are obtained
Data Type

Prompt for value
using the following
text

Use the following
value

Get the value from
the following
window field

Use Default value
from the report
Current User ID

Current Company ID

This radio group determines how the parameter selected in the Parameters list will be
populated at the time the report runs.

This read only field shows the data type of the parameter as defined in the report.

This radio button option and text box enable the selected parameter value to be
supplied by the end user manually. The text entered into the text field will be
presented to the user in a dialog box where they must type a value to be passed to the
selected parameter.

This radio button option enables a text box where a value for the parameter can be
defined and saved during setup.

This radio button option and text box enable the selected parameter value to be
supplied from a field value on the window selected on the Window tab.

The field to be used can be selected manually using the Field Lookup Parameter
window or by point and click with the Help Me Choose Parameter Field Picker.

This radio button is enabled if the selected report parameter has a predefined default
value. This selection allows Forms Printer Plus to ‘ignore’ the selected parameter and
not try to pass a value to it.

This radio button allows you to pass the User ID of the currently logged in user to a
parameter on the report.

This radio button allows the Company ID string to be passed to a report parameter.
This enables the company to be referenced for Datasource access in printing SSRS
reports. In SSRS and Crystal Reports it provides a way to programmatically access
company specific information or control formatting based on company.

Note: If the selected report has more than one parameter, you will need to select each parameter

individually in the parameters list by clicking on it to highlight it. Then, define the manner in

which its value is to be obtained by selecting the desired radio button option and supplying the

required value.
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Window Example - Parameters
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E@] Farrs Printer Plus Setup

=i} Savel ] New‘ x De\elel > HepoltEngmeSelup‘

===

- Microsoft Dynamics GP
Inwentoy
- Sales
] Customer Inquiry
] Customer ltem Maintenance
1] Customer Summary
-3 (&l Companies]
[E] Customer Summary
[ System
=+ Forms Printer
System

Company I Window I Frint Imitiatian I Heporll Parameters | Defivery Options I Hewewl

Parameter Setup

Specify how the report parameter valuss are obtained

Select a parameter from the list to specify the source of the parameter value.

Paramaters

Parameter Dats Typs: Sting

How parameter value is obtained

) Prompt for value using the follawing text:

[Enter Customer Humber |

(2 Use the following value:

@ Getthe walue from the fallowing window field:

Customer Mumber

[ HelpMe Choose | [ FieldLookup,

() Use default value from the report
(@) Current User ID
() Current Company 1D




Field Lookup — Parameter Window

The Parameter Field Lookup window, when opened from the Print Initiation tab is used to select the
button from which the Forms Printer Plus report will be run. The selection of the button is made manually
on this window by choosing from the list of buttons available on the window chosen on the Window tab.

Note: If unsure of the button, the Help Me Choose option provides a ‘point and click’ selector that will
identify the button by clicking on it.

Picker mode can be canceled at any time by returning to the Forms Printer Plus Setup or Wizard
and clicking the Cancel Picker button shown in place of the Help Me Choose button.

Window Buttons

Button Description

Select This button closes the Field Lookup window and returns the selected information
to the wizard.

Cancel This button closes the Field Lookup window without returning information to the
wizard.

Window Fields

Field Description
Form Displays the form name of the selected window.
Window Displays the name of the selected window on which the report will be run.

This checkbox changes which fields are shown in the Fields list. With the box checked,
Include Local Fields all fields created as part of the current form will be shown along with table fields and

window controls, such as buttons, dropdown lists, etc.

This list displays all of the fields available from the selected window which can be
Fields chosen to supply the parameter value. Choose the desired field and then click the

Select button to close the Field Lookup window and return the selection to the wizard.

Window Example — Field Lookup

5@ Field Lookup E[E[ =]

File Edit Tools Help Debug 3 Fabrikam, Inc. 4/12/2017

aintenance: ]
aintenance. ]

[ Include Local Fields

Fickds
Field Name Datatype

Address1 String
Address2 Strin
Address3 Strin

Address Code Strin,
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Help Me Choose — Parameter Field Picker

The Help Me Choose button puts the wizard into a “Picker mode”. When opened from the Parameter tab,
this mode is used to map parameters on the select report with fields on the window that can supply that
value to the parameter. To choose the field using the picker, first click on the Help Me Choose button
from the Parameter tab. Dynamics GP will be brought to the foreground. If the window chosen from the
Window tab was not closed, it should be the focused window. If it isn’t, navigate Dynamics GP through the
normal menu selection or other navigation methods and open the window chosen on the Window tab.

Once the window is open, Picker mode will be indicated by a change in the cursor to the image shown
below:

e

Click on the desired Field to select it and return the field information back to the Forms Printer Plus
Parameter tab.

Note: Only fields visible on the window can be selected while in Picker mode. Many other hidden fields
are available with valid data and may be desired as the source of a parameter’s value. To select
any of these hidden fields, you must use the Field Lookup where the entire list of fields on the
window are displayed.

Because the window has already been selected in the Window tab, Picker Mode will not allow
any field except those on the selected window to be returned to the wizard.

Picker mode can be canceled at any time by returning to the Forms Printer Plus Setup or Wizard
and clicking the Cancel Picker button shown in pace of the Help Me Choose button.

Page |57



Delivery Options Tab

The Delivery Options tab is used to define default options relating to report dissemination. When printing
a Forms Printer Plus report, the end user will be presented with a Report Options window where Preview,

Print, and To File options will be avail

able. In addition, the option to Deliver will also be available from the

Print Options menu. The settings for this selection are determined on the Delivery Options tab. All

settings determined in this setup become the default when Deliver is selected from the Report Options

window and all delivery options apply automatically without the need for end user intervention or

selection.

Window Example

L:i] Forms Printer Plus Setup Wizard

‘ Welcome |Cnmpany | Window | Prit Initiation | Report | P Delivery Options |REview|

Delivery Options

Specify how the report output is delivered

ToFile File Format | Adobe FDF -

Save Folder C

MUsershdnovak ACCOUNTABLE Desktop [S1E Y

To Printer Frint Using [Spadﬁc Printer ']

Printer H

P Officejet Pro 8500 A909g Series fredirected 2) >

[¥] To Mail

Mail From

@ UseOutlock @ Use Crystal MAPI [Moba PDF -

Attachment Format

Attachment Name

- | >

Mail To

Subject

Window Fields and Controls

@ Prompt For Email () Manually Entered kd
Message
d
Send Option Hours to Delay
Send Directly x| (0
e
Rezdy.

Fields Description

To File Mark thi

s checkbox to have the report exported to a file each time it is delivered,

regardless of whether ‘File’ was selected as the destination on the Report
Destination window.

File Format The File Format selection determines the format for the exported document.

Save Folder Determines the directory in which Forms Printer Plus will create the exported file.
This is the path to the directory, and does not include the file name. This folder
can be determined in one of two ways:

1.

2.

Using the Folder Browse Button. Forms Printer Plus automatically names
the file to ensure a unique file name is created. The file is named with the
convention: Report Name System Date System Time.format

Where Report Name is the Report Setup Name entered on the Review
tab.

For Example: My Plus Report 06 25 01 8 30 27AM.PDF

Using the editor window to build the folder path using manually entered
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Folder Path

To Printer

Print Using

Copies To Print

To Mail

Use Outlook

Use Crystal MAPI

text and / or tags from window field values.
NOTE: Whether manually selected, entered, or built through tags, the folder must
exist. Forms Printer Plus will not create the folder.
This button opens the Folder Path window which allows the building of the Export
Directory when using the To File feature of Forms Printer Plus. See the Folder Path
section for more detail.

Selecting the ‘To Printer’ checkbox enables the Forms Printer Plus printer output.
Marking this option will send a copy of the report to the printer whenever the
Deliver option is used. Left unmarked, the report will only print to the printer if
the ‘Print’ option is selected on the Report Destination Window.
Print Using determines where the document will be printed when used within
Microsoft Dynamics™ GP. The valid choices are described below.

Printer Saved On Report — Crystal Reports ONLY
This setting will direct the Crystal report to the printer saved in the
Crystal Report Designer Print Setup window when the report was
designed or modified. If the report has no defined printer or the defined
printer is not available from the workstation, the default system printer
will be used.

Default System Printer

This setting instructs Forms Printer Plus to print the selected report to the
default printer defined on the user’s workstation.

Ask Each Time Report Prints

This setting will allow you to select the printer at the time the report is
printed. Using this setting will direct the report to the selection made
during the printing process.
Specific Printer
The specific Printer option enables the Printer selection button where a
Print window can be opened and used to define the printer and its default
settings.
Number of copies determines the quantity output to the printer when the report
is printed. This quantity will override any quantity selected from the print dialog
within the report print setup, or the system default print setup. If using ‘Ask Each
Time Report Prints’, then the number of copies entered in the properties window
will be used.
Selecting the ‘To Mail’ checkbox, allows delivery of the selected document by
Email.
Forms Printer Plus will automatically detect whether Microsoft Outlook is
installed, and enable or disable the Microsoft Outlook Radio button and some of
the Email options accordingly.

Note: If using SSRS as the Reporting Engine only Use Outlook is enabled.

If Outlook is not detected and the Reporting engine is Crystal Reports, then Forms
Printer Plus will use the Crystal Reports MAPI mailing functionality, and
automatically mark the Crystal MAPI Radio button, disabling the option to use
Microsoft Outlook. Even if Outlook is installed, you may still choose to use Crystal
MAPI Mail by selecting the Crystal MAPI Radio button.

Because of the limits of the Crystal API, certain functionality is unavailable when
not using Outlook.
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Mail From

Mail To

Send Option

Hours To Delay

The functional limits when using Crystal MAPI functionality are:

1. You cannot specify an ‘Email From’ profile.
The default profile will be used as the ‘From’ address.

2. You cannot name the attachment.
The attachment name will be the same as the Crystal Report

used to create it.

3. You cannot specify the Send Option.
The Email will be sent automatically to the recipient.

The ‘Email From’ dropdown list will be enabled if Microsoft Outlook is installed.

This dropdown list is populated by default from the Outlook Global Address List.

Here you have the option to use the default Outlook User, or specify a specific

profile to use as the ‘Send On Behalf Of mail ‘From’. If using a profile other than

default user, the default user must have ‘Delegate’ permissions in Outlook. For
more information about this topic, please see the Outlook help documentation
regarding Delegates.

Note: In order to use the ‘To Mail’ feature of the Forms Printer Plus Delivery,
the client workstation must have a Messaging Application Programming
Interface (MAPI) compliant Email application loaded. The full version of
Microsoft Outlook is currently the only supported MAPI client According
to the Crystal /Business Objects/SAP web site.

To have access to all of Forms Printer Plus’s Emailing functionality, it is
recommended to use Microsoft Outlook 2000 or Greater.

Additional help with Email issues can be found in the Troubleshooting
Email Errors section of this document.

The Email To radio group allows a selection of either Prompt For Email or Manually
Entered. To have the printing user enter an Email address at the time the Email is
created, leave the default of ‘Prompt’. To enter a hardcoded Email at the time of
setup, mark the Manually entered option and enter a valid Email Address or semi
colon separated list of addresses.

The Send Option dropdown list allows you to select the destination for the created
Email.
The selections for Send Options are described below.

e Send Directly to Email Recipient: Automatically sends the Email.

e Save To Outlook Drafts folder: Creates the Email in the Drafts folder.
Email must be sent manually.

e  Save to Outlook Outbox: Creates the Email and saves it to the Outbox.
Email must be sent manually.

e  Save to Outlook Outbox Delayed: Creates the Email and saves it to the
Outbox. Email will be sent automatically at the specified time selected by
the Hours to Delay option.

e Display created Email: Creates the Email displays the Email rather than
sending or saving it. Once any required modifications are made, the Email
can be modified and then saved or sent manually.

The Hours to delay option is enabled when the Send Option dropdown list is set to
‘Save to Outlook Outbox Delayed’. Setting this number adds the specified number
of hours to the current system time, and uses that to set the Email’s delayed send
property. For example, if the Email was created at 10:15 AM, and the Send option
was set to Save To Outlook Outbox delayed, with an Hours To Delay setting of 12,
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Attachment Format

Attachment Name

Subject

Message

the Email would be created in the Outbox, and would stay there until 10:15 PM,
and then it would be Emailed to the selected Recipients.
The Attachment Format dropdown list allows you to specify the format for the
Email attachment.
The Attachment Name allows you to enter the text, as it will appear in the Email
for the attachment name. To create a calculated Attachment Name, open the
Subject and Attachment Name Editor window using the expansion button. When
creating an attachment name, the following characters should be avoided, as they
are invalid in the name of a file:

\/?*:“<>|

See the Editor Window for specifics on creating a parameterized Attachment
Name.

Email Subject sets the text, as it will appear in the Email Subject line. To create a
calculated subject, open the Email Subject Editor window using the expansion
button. See the Editor Window for specifics on creating a parameterized Subject.
This field displays the Message as it will appear in the Email body. To create a
calculated Message, open the Email Message Editor window using the expansion
button. See the Editor Window for specifics on creating a parameterized Message.
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Folder Path
The Folder Path window is used to create a custom file path for use when exporting to file through the

delivery system. This feature allows the folder to be created at runtime based on data associated with the
selected window. All fields associated with the window are accessible for the parameterized folder path
and are listed in the Window Fields list.

=i File Nama = = E

Fie [df Toohs Help v Fybaicam, Inc. 41517
# on |[5) Oea

‘wirckow Feks Sy, Fnkehy
 comamertiomeer - | | o o
= Hald o [ Lhars Magter
L [nnetme
M Custamer Mars
L et Masea
L2 SEateereens Maemg

When creating the folder path, there are several rules that Forms Printer Plus will follow. Those are:
1. The folder path must not contain any characters that are invalid in a Windows folder path.

2. Forms Printer Plus will look for the path as defined and, if found, will create a file using the text
provided as the Report Name in setup. For example, the folder path below would expect there to
be a folder with the Customer Number as its name that exists as a subfolder named
“myreportfolder” on the “n” drive.

ONLY FOLDER DEFINED: n:\myreportfolder\ {<WF>Customer Number}

3. The defined folder path MUST exist and be a valid path from the printing workstation. Forms
Printer Plus will not try to create the folder path at runtime. If the folder does not exist, reports
defined to go to that folder will fail and must be reprinted.

4. Any part of the folder name can be parameterized but when parameterizing the folder path,
remember rule #2.

5. If a duplicate file name is created as a result of exporting to file, Forms Printer Plus will overwrite
the Results
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Editor Windows

The Editor Windows (Message, Subject and Attachment) are used to create the various elements of the
Email. These elements can be manually entered text, or a combination of manually entered text and
parameter fields added from specific window fields, system fields, and global fields. When the Email
element is created and assigned to a particular report setup, Forms Printer Plus will fill in any parameters
using data from the record displayed in the selected window at the time the report is being Emailed.

Window Example

Ei] Email Message
File  Edit Tools Help

@ ok Clear

(===

sa Fabrikam, Inc, 4/12/2017

‘Window Fields:

Customer Number -
Haold
Inactive

Customer Name
Shart Marne
Staternent Mame

[ | 3

Global Fields:

w-E System Fields

Note: Parameters appear in the Message Editor Text field surrounded by {}. These brackets and all of
the text that appears between them are required in order for Forms Printer Plus to pull the
correct information. The parameters shown in the message will be replaced with the actual value
of the fields when the Email is created. These parameters should not be altered in any way.

Window Fields

The Window Fields List displays the fields available to be used as parameters from the selected window.

Double clicking on a field adds that field to the text box.

System Fields

The System Fields List displays system fields available to be used as parameters. Double clicking on a field

adds that field to the text box.

Global Fields

The Global Fields List displays global fields available to be used as parameters. Double clicking on a field

adds that field to the message text box.

Page |63




Review Tab
The review tab provides includes a field for naming the report setup as well as a summary of the options

selected across all of the setup tabs in the wizard. Use it as an opportunity to check that the setup is as
expected.

*At this point you can move back and forth between the various setup tabs as needed to correct or adjust
settings.

Once completed, clicking the Save button will create the setup and return to the Forms Printer Plus Setup
window. If there are any issues, a dialog box identifying information that might be missing or incorrect is

displayed.

Window Fields

Field Description

Report Setup Name This field is used to enter the display name of the report setup.
Review pane The review pane shows the selections made on the various windows.

Window Example

Ei] Forms Printer Plus Setup Wizard EI

‘ Welcome | Company | Window | Print Initiation | Report | P; Delivery Optinnsl Review ‘

Review and Finish
Review your setup and specify a name

Feport Setup Mame Customer Summary Report

MNew Report Setup -
‘Available for All companies

Prirt from window Customer Maintenance of product Project Accounting

Print from Additional menu. The Additional menu will appear after the selected window is closed and reopened
Print Crystal Report " \ACCOUNTABLE12\Acc Team\Groups'\Developmert\FPP Reports\Customer Summary rpt

Report Parameters
Customer Number = Prompt For Value

Note: *Be aware that a change on one tab can have affects across all of the other tabs in the setup. A
change to the selected window or report for example can greatly change the setup thereby
facilitating the need to redo most if not all of the setup.
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Printing with Forms Printer Plus
Once setup has been completed, the report and its delivery will be available for printing using the defined

button or menu item.

Note: If the report setup In order to ensure that the printing works as expected, be sure to close and
reopen the window selected in the Window tab before printing your report.

To print the report, close and reopen the window on which you’ve added the report. Fill the window with
the intended record and then click the defined button or select the created menu option from the
Additional menu. Forms Printer Plus will begin the printing process and present the Forms Printer Plus
Report Destination window where options can be selected for processing the report.

Report Destination Window
The Report Destination window in Forms Printer Plus is similar to that which is found in Dynamics GP with

the exception of the added Deliver option and the available file formats for export which vary depending
upon whether the report was created in Crystal or SSRS.

Choosing the Deliver option means that Forms Printer Plus will use those options defined in the Deliver
tab of the setup and will send to file, printer and / or Email as defined.

Window example

Form Printer Plus Report Destination

Report Information
M ame: Cusztomer Summary Crystal Report
Option: Forms Printer Plus

Engine: Crystal Report

Destination

[T Screen
[ Printer
[ Deiiver:
[ File

File Mame:

File Format:

Append @ Replace
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Crystal Reports Setup

The Crystal Reports provided with Forms Printer are samples, intended to be used as templates and are
meant to be generic examples, rather than the solution to every printing situation. These reports will need
to be modified in order to handle specific needs. Before modifying the sample reports, it is recommended
that you have an understanding of Crystal reports. If you are unfamiliar with Crystal reports, the quick
setup is the easiest way to get up and running with the sample reports. If your report modification
includes adding tables to the sample reports, follow the instructions in the Modifying Sample Reports
section pertaining to your database type.

Using Template Reports
The template reports installed with Forms Printer are “generic”, that is: they are designed to work

immediately after installation without the need for modification. Of course, you will at least want to make
cosmetic changes to the logo and company name, etc. These changes can be made very simply without
complex modification to the report.

However, if you are adding tables to the report, or making other more significant changes you must follow
the report modification instructions in the Modifying Sample Reports section.

Installed Template Reports
The Forms Printer Crystal Reports templates are installed into the following folder:

[Dynamics GP Application Folder]\Forms Printer\Crystal Report Templates
Within that subfolder are several subfolders for the supported Dynamics GP series.

Modifying Sample Reports
Step |

Make note of the settings for the DSN used by Microsoft Dynamics™ GP. (Start->Control Panel-
>Administrative Tools->Data Sources (ODBC)

Step Il

Use similar settings to create a temporary named second DSN, using a unique name for the Data Source
Name. For example, use ASIFPTemp. This temporary DSN may be set to use a Microsoft Dynamics™ GP
company database (EX: TWO) as the default, but it is not required.

Step i

Open the sample report using the Crystal Report Designer.

From the toolbar, click Database.

From the dropdown menu, select ‘Set Datasource Location...’

From the ‘Replace with’ list at the bottom of the window, expand ‘Create New Connection’.
Expand ‘ODBC (RDO)'.

From the ODBC (RDO) window, Select the ASIFPTemp DSN from the Data Source Name list,
and then click ‘Next’.

- D o0 oW
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From ‘Connection Information’, enter a valid User ID and Password.
From the Database dropdown list, select your Company Database.
Click ‘Finish’.
Back on the Set Datasource Location window, expand ‘report’ in the ‘Current Data Source’ list.
Highlight the DSN listed.
From the ‘Replace with’ list, highlight the ASIFPTemp DSN listed below ‘ODBC (RDO).
. When both DSNs have been highlighted, click ‘Update’.
Click ‘Close’ when finished.

533" FAT T 5@

Step IV
Follow the Crystal Reports Application documentation for adding tables in the Crystal Report Designer
using the ASIFPTemp DSN.

Step V
Save the Crystal Report in the directory used in the Forms Printer setup.

NOTE: Repeat Steps Il through V for each Sample Report you need to modify.

Step VI
Once each of the reports you intend to modify have been corrected, delete the ASIFPTemp DSN
created in Step I. This allows the generic report to be printed from multiple company databases
using the DSN used to log into Microsoft Dynamics™ GP.
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SQL Reporting Services Setup

Modifying Forms Printer SSRS Reports

The SQL Server Reporting Services (SSRS) reports that ship with Forms Printer are samples intended to be
used as templates for designing reporting solutions. They will need to be modified before use with Forms
Printer in a production environment.

The reports may be customized and deployed using the SQL Server Business Intelligence Development
Studio application or the Visual Studio application.

Use the following steps to customize a Forms Printer SSRS report, and deploy it to your Report Server, for
use by Forms Printer in Dynamics GP.

Installed Template Reports
The Forms Printer SQL Reporting Services templates are installed into the following folder:

[Dynamics GP Application Folder]\Forms Printer\SRS Report Templates
Within that subfolder are several subfolders for the supported Dynamics GP series.

Steps for Customizing SRS Report Templates
1. Create New Report Server Project. Modification of an SSRS report first requires the creation of a

new Report Server project in your application.
a. Launch either Business Intelligence Development Studio or Visual Studio.
Create a new Report Server project by using the Report Server template. The Report
Server template can be found under Business Intelligence Projects in the New Project

window.
& Microsoft Visual Studio [=lE=]
F1® New Preject =
Project types: Templates: ] (=)
Business Intelligence Projects Visual Studie installed templates
Visual Basic 15 Analysis Services Project SImport Analysis Services 9.0 Database
Visusl C2 %) Integration Services Project CIReport Server Project Wizard
Visual Ce+ [Z]Report Model Project = Report Server Project
Other Project Types
My Templates
Test Projects
2 Search Online Templates...
Create an empty Report Server project.
Name: Report Projectl
Location: Ci\Projects -
Report Projectl ] Create directery for solution
[] Add to Source Control
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2. Create New Shared Data Source

All Forms Printer SSRS reports are configured to use a data source called GPCompany for data
retrieval. You will need to create this data source in your project. The new data source should
point to a Dynamics GP company database on your SQL Server. To create the data source, right
click on the Shared Data Sources folder in the Solution Explorer window and select the context
menu item to add a new data source. Name the data source GPCompany and set the connection

string to point to a Dynamics GP company database in your SQL Server.

& Report Project] - Microsoft Visual Studio = |[= ] =]

N — | Window Community Help
«# Shared Data Source g2
- | B ';'
General | Credentials Solution Explorer - 3 x
MName: = | &
GPCompany _.,] Report Projectl
| Shared Data Sources
Type: . 4-;» GPCompany.rds
Microsoft SQL Server - 1 Reports
Connection string:
Data Source=localhostInitial Catalog=TWO %
oK l l Cancel ] l Help ] l—“iJSqution e |34 Toolbox ﬁ:Prcpaties
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3. Add Forms Printer SSRS Report To Project

Next, you will need to add the SSRS report that you wish to modify into your project. In the
Solution Explorer window, right click on the Reports folder and select Add, then Existing Item.
Browse the file system to find the Dynamics GP install folder. The Forms Printer SSRS reports are
located in Dynamics GP Series sub folders of the folder SRS Report Templates, a sub folder of the
Dynamics GP client application folder.

Add the report(s) that you wish to modify. The report layout, and SQL query can then be modified

as desired.
" Report Project] - Microsoft Visual Studic ===
File Edit View Project Build Debug ANTS  Tools Test ReSharper Window Community Help

Gl - - E @ o Close % B3 #4 b Debug - Default - | -

SOP Unposted - Al..Types.rdl [Design]& ~ X | Solution Explorer >3 x
5] pata | Layout |[Z Preview = | 2

B O D O e ;_;-,'.]REpOrtPrOJect]

= Shared Data Sources

:| ¥ Page Header i . ¢ GPCompany.rds

M- — - [ Reports

- ® - - - =

. cc ou n a e .............. [ SOP Unposted - All SOP Types.rdl
5w Software

||| #Body

: =iif{Fields!DOCTYPEValue = S PO Number

Z =Fields!DOCDATEValue =Fields!CSTPONBR.Value

Bill To: e [ o

- =Fields!BillIToAddressBlock Value =Fields!ShipToM
S -

||« 1 * I—'fi]SDIution Explorer |23 Properties

Ready

All parameters that are passed to each report by Forms Printer are already defined in the report.
Note that the order and data type of the report parameters are important for proper execution of

the report by Forms Printer.
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4. Deploy Modified Report To Report Server

Once you have completed customizing the report, it can be deployed to your Report Server.
Before deploying the report, configure the deployment properties of the project in order to
specify the location of the Report Server and the target folders on the Report Server for your
report and data source. The deployment properties can be set by opening the project property
page from the project menu or from the project folder context menu in the Solution Explorer

window.
& Report Project] - Microsoft Visual Studio == ez
Report Projectl Property Pages == ARGy [E
Configuration: | Active(Debug) - MN/A Cenfiguration Manager.., ‘
= Configuration Properties B Debug bplorer - Report .. » 1 X
.. General Startttem
E Deployment -
Overwrite DataSources False prt Projectl
Target DataSourceFolder Data Sources hared Data Sources
Target ReportFolder Forms Printer Reports :» GPCompany.rds
Target Serverl JRL hitp:/Aocalhost/Report Server/ eports
lil SOP Unposted - All SOP Ty
Target ServerURL
For a report server runining in native mode, the path to the report server where the
project is deployed, for example http://servemame.reportserver. For a report ser..
1 ¢
[ oK ] I Cancel ‘ App n Explorer |25 Properties

Ty

Once the deployment properties have been set, the report can be deployed to the Report Server
by selecting Deploy from the Build menu or from the context menu of the report in the Solution
Explorer window.

After the deployment has completed successfully, the report can be selected for use in the Forms
Printer Setup window in Dynamics GP.

Deploying Unmodified Forms Printer SSRS Reports to a Report Server

There may be circumstances when you wish to deploy an unmodified Forms Printer SSRS report to your
Reporting Services Report Server, for instance, when preparing a product demonstration. In such cases,
the Reporting Services Report Manager web application can be used to perform the task. The Report
Manager application allows report files to be uploaded to the Report Server database, which is equivalent
to publishing the reports. Follow these steps to deploy a Forms Printer SSRS report to the Reporting
Services Report Server, for later use by Forms Printer in Dynamics GP.

1. Upload Report File To Report Server
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Launch your web browser and navigate to the Reporting Services Report Manager web
application. By default, the URL is http://<servername>/Reports. Click the Upload File link on the
Contents tab of the Home page, or on any folder page. This will open the Upload File web page.
Browse to the report file on your file system that you wish to upload and select it. The Forms
Printer SSRS reports are located in the Stub SRS Reports folder beneath the Dynamics GP install
folder.

Press OK to upload the report file into the Report Server database.

/€ Report Manager - Internet Explorer = =2
@ i - |.6_; http://192.168.1.35:8081/Reports/Pages/Import.a ~ | s | A | | Google £~
v e (& Report Manager B ~ &~ 4 gﬂ o> Q' oo

Home | My Subscriptions | Site Settings | Help =
=| SQL Server Reporting Services —
1 Upload File Search for: (Gol

Upload a report or resource into GP Forms Printer Reports. To upload a report, choose a report
definition (.rdl) file.

File to upload: port Project1\SOP Unposted - Al[ Browse..
Name: SOP Unposted - All SOP Types

Overwrite item if it exists

Iﬂl Cancel

2. Configure Report Data Source

Once a report has been published on the Report Server using the Report Manager, you will need
to configure its data source. All Forms Printer SSRS reports are configured to use a data source
called GPCompany for data retrieval. If this data source does not exist on your Report Server, then
you can associate the report with any existing data source that points to a GP company database.
To do this, click on the link for the report in Report Manager to open the report. Next click on the
Properties tab at the top of the page, and then click on the Data Source tab at the side of the
page. In the Data Sources page you can browse and select an existing GP company data source for
your report.
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/€ Report Manager - Internet Explorer [= ==

@'\_/' - |g. http://192.168.1.35:8081/Reports/Pages/Report.aspxiltemPath=2%62fGP+Forms+Prin. = | "?| A | | Google

o
W [@Repor‘cManager l_l v G o) b A b -

Home | My Subscriptions | Site Settings |

SQL Server Reporting Services

Help
B Home = GP Forms Printer Reports == Search for:
2l SOP Unposted - All SOP Types

@Pmperﬁg History | Subscriptions

GPCompany

General

Parameters @ A shared data source

Data Sources /Data Sources/GPTWO

Execution ) A custom data source

History
Security

Microsoft SQL Server

:

After you have applied the change to the data source of your report, the report is ready for use by Forms
Printer. The report can be selected for use in the Forms Printer Setup window in Dynamics GP.

Multi Company SQL Server Reporting Services Reports

We recommend two techniques for configuring SSRS reports for use in a multi company environment.

1. Publish a Copy Of Each Report For Each Company
Using the Report Manager Web application, a report can be published to multiple folder locations on the

Report Server, with each copy configured to use a different company specific data source.

2. Configure Each Report to Dynamically Select a Company at Run Time
Using the report designer application, the data source definition of the report can be modified to use the

value of a report parameter, in order to specify the company database in which to execute the report
query.

This will require changing the report from using a shared data source to using an embedded data source.
The connection string of the embedded data source can be defined as an expression that dynamically sets
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the company database from a report parameter value. Below is a screenshot of the Data source window
using a dynamic connection string.

@ Report Project - Microsoft Visual Studio [==]r=R]
File Edit View Project Build Debug ANTS Format Report Tools Test ReSharper Window Community Help
D~ | @ o Close [ b Debug « Default - | [#% Map .|z
-z i i
SOP Unposted - AL Types.rdl [Design]a ~ 3 | Solution Explorer - Report Projectl -3 x
[ pata |{§) Layout | ) Preview = | 2
_ %] Report Project1
Dataset # 3 2|EE=ED) ¢ = = 5 B Soare Dot Sources
-l Dataset =] “|| . - & GPCompany.rds
= [ Reports
Query | Fields | Data Options | Parameters | Filters | . [5] SOP Unposted - All SOP Types.rdl
Mame:
GPCompany
Data source:
[6PCompany - E]
«p Data Source =]

General | Credentials

Name:

GPCompany

Type:
Microsoft SQL Server -

Connection string:

="Data Source=localhostInitial Catalog=" & Parameters!CompanylD.Value

[] Use shared data source reference

Reference:

[] Use single transaction

E] Datasets| 3% Toolbox |3 Properties | €3] Solution Explorer

oK H Cancel H Help

Use the following steps to configure a particular report to use a report parameter value for company
selection:

1. Openthe reportin a Report Server project in Business Intelligence Development Studio or
Visual Studio.

2. Select the Data tab of the report in the design surface.

3. Open the Dataset window for the GP Company dataset, by clicking on the ellipsis button next
to the Dataset drop down list in the Data tab.

4. Open the Data Source window for the dataset, by clicking on the Data Source ellipsis button in
the Query tab of the Dataset window.

5. Uncheck the Use shared data source reference check box.

6. Set the data source type to Microsoft SQL Server.

7. Enter an expression for the connection string, setting the Initial Catalog to be the value of the
report parameter that specifies the current company database in Dynamics GP:

8. ="Data Source=localhost; Initial Catalog=" & Parameters!CompanylD.Value

9. Specify the credentials for the data source.
10. Save and publish the report to the Report Server.
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Report Requirements and Considerations

The reports you choose to use when printing with Forms Printer can be simple modifications to the Crystal
or SRS report templates shipped with Forms Printer or they can be created from scratch in your tool of
choice.

In either case it is important to note that ALL Forms Printer reports have certain requirements and critical
considerations regarding their design and content.

Report Requirements
The requirements for reports to be printed using Forms Printer are all based upon the report’s

parameters. Reports used in Forms Printer will error if the following parameter requirements are not met.
The requirements are:

1. The Minimum Parameter Count - Your report may have more than the required parameters
but may not have fewer than those indicated in the templates or errors will occur and the
report will not print.

2. The Parameter Order

The Parameter’s Data Type

Important Considerations
Along with Parameter Requirements, each report has important considerations which must be understood

and in MOST cases, heeded so that the report can display as intended. These important considerations

include:

1. Report Tables
2. Report Table Joins
3. Report Selection Criteria

While a report used in Forms Printer will not error without the suggested tables, joins and selection
criteria, there is a VERY likely chance that the report will not display the correct data intended by the
Dynamics GP printing process if any of these considerations are not followed.
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Troubleshooting Guide

Initialization Error

The Add-In Initialization Error occurs when there is a mismatch between the Forms Printer Add In dlls and
the Forms Printer dictionary (.dic) file versions. The most likely cause of this is error is that the Forms
Printer FPD1230.dic and ASI1655.dic files were not removed from the Dynamics GP client directory after
the installation process and prior to launching Dynamics GP.

The error dialog is shown below:

Add-In Initialization Error

FormsPrinter.dll: Exception has been thrown by the target of an invocation. InnerException: The type initializer for
'FormsPrinter, GRAddIn' threw an exception.

You can correct the error by removing, or renaming the FPD1230.dic and ASI1655.dic files and then
launching Dynamics GP again.

Installation Errors

SQL Installation Errors

If you receive an unsuccessful message when installing on a SQL database, you may be able to determine
what SQL Table or Stored procedure is causing the initialization to fail by using "Dexterity SQL Logging" on
the workstation on which you are trying to initialize. This is done by editing the [General] section of the
DEX.INI file to include the following lines:

e SQllLogPath=c:\
e SQlLogSQLStmt=TRUE
e SQlLLogODBCMessages=TRUE

Then log into Microsoft Dynamics™ GP and attempt to Initialize Forms Printer- a log file named
c:\dexsqgl.log will be created, and if you open it with notepad at the point of the error, you will see the SQL
statement that caused the error: You may be able to delete the ASI123* table (if it contains no data) and
its associated zDP_ASI123* stored procedures and then try again and see if you get past the issue.

If you can send that dexsqgl.log to us, we may be able to determine what is happening.

NOTE: After logging out of Microsoft Dynamics™ GP, be sure to remove the lines above from DEX.INI or
set them to FALSE so as to not affect performance of your system or fill up your disk with the log file.
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Registration Errors
When entering Registration keys, a failure to register warning typically occurs for 3 main reasons:

Cause ~Resolution

Mistyped Registration Keys Double check the keys entered and use cut and paste if possible.

Double check the site name on the Registration Keys document
Incorrect Site name provided by Accountable Software. If there is a discrepancy from your
actual Site name, contact us to receive a new set of keys.

Double check the number of licensed users enabled by the keys issued
Incorrect User Count and compare to your number of System Manager users. If the keys
enable fewer users you will need to contact Accountable for new keys.

Report Parameter Errors
The error ASI_SetParameters shown below occurs when the report being printed has fewer parameters

than is expected by Forms Printer.

This error is followed by the dialog below which displays the ParamNumber, and the ParamValue.

AS]_SetParameters: Paramiumber=7 ParamType 4 IParamValue TWO

ParamNumber indicates which Parameter on the report has the issue. ParamValue indicates the value
that was passed to that report parameter.

To correct report parameter issues, compare the parameters of the report being printed to the matching
template report shipped with Forms Printer.
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Email Setup Errors
In order to function properly, Forms Printer must find an Address list for possiblEmail source addresses.

By default, it attempts to use Outlook and an Address List named “Global Address List”, which exists by
default in Microsoft Exchange environments. If Outlook or this address list is not found, errors will occur
during Forms Printer Setup.

The symptom, possible cause and resolution are listed below:

Symptom Cause Resolution |

If you are not using Outlook as your Mail Client, you may set
the ASIFPUseOutlook Dex.ini setting to FALSE. This will
disable the Outlook option completely, and Forms Printer
will not try to connect to Outlook in any way.

Outlook is not
installed or in use
on the Client
machine.

The cause of the dialog is that Forms Printer is unable to
retrieve the Required Address List while communicating with
Outlook.
Error “Can’t get address list
object with this name from You can change which Address List Forms Printer attempts
Redemption object” or similar. to use by changing the ASIFPOutlookFolder setting in the
Dex.ini file. The list name entered in the Dex.ini must be a
valid Outlook Address List. For Example, you could change
the list to the Outlook ‘Contacts’ list by changing the Dex.ini
setting to: ASIFPOutlookFolder = Contacts where by default
it is ASIFPOutlookFolder = Global Address List.

Some functionality of Mail

delivery is restricted similarto  The client machine

the restrictions for Crystal failed to retrieve

MAPI. the Exchange
ServerGlobal

Address List
If your environment is such that you cannot create a

Contacts or other common address list that would be
available on each workstation, you can set the Address List
to use to be “ASIFPOutlookFolder=NONE which will
preserve most functionality, but only allow sending from
“Default Outlook User”.

This option is useful when using Outlook Offline while
testing or demoing Forms Printer.
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Invalid TLV Record Error

When using Crystal Reports as the reporting engine, the “Invalid TLV Record” error is displayed for two
known reasons:

Cause Resolution |

Re-run the Forms Printer install on the workstation, ensuring the correct Forms
Printer and version of Crystal Reports is used.
The Crystal Report rpt file was saved  Or

using a Crystal Reports application Open and save the report in a version of Crystal compatible with the version
version that is not compatible with installed on the workstation.

the version of Crystal Reports dlls

registered on the workstation. NOTE:

Advanced users may wish to use the Registry Editor to check the registered
version of the Crystal dlls. That version can be found in the key:
HKEY_CLASSES_ROOT\CrystalRuntime.Application\CurVer

Replace the dlIs in the Dynamics GP folder with the version that matches the
currently registered Crystal dlls.

To replace these files first requires that the version registered is identified. To
do this, advanced users can use the Registry and follow these steps:
1. Find the key:
HKEY_CLASSES_ROOT\CrystalRuntime.Application.11\CLSID
2. Copy the listed GUID
3. Search for that GUID under the key:
HKEY_CLASSES_ROOT\CLSID
4.  When found, expand to see the folder InprocServer32
5. Click on the folder to see the results on the fight hand pane
6. Check the Data column value. Here will be displayed a path to
the registered Crystal dlls.

The Crystal Reports dlls registered on
the workstation do not match those
installed to the Dynamics GP folder
and being used by Forms Printer.

Note that this occurs when an If the path is:
installation discrepancy between <drive>:\Program Files\Common Files\Business
Crystal Reports Xl and Crystal Objects\3.0\bin\craxdrt.dll
Reports XI “R2” (release 2) exists. Then the registered version is Crystal XI “r1”
If the path is:

<drive>: Program Files\Business
Objects\Common\3.5\bin\craxdrt.dll
Then the registered version is Crystal XI “r2”

The resolution to this issue is to replace all dll files in the Dynamics GP client
folder that begin “CRPE” with the correct version identified by the above

procedure. The correct version of these files can be found at the paths listed
above in blue. B sure to copy the matching version identified in the registry.

Blank Statement
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Frequently Asked Questions

Question: What version of Crystal Reports does Forms Printer install and support?

Answer:  As of version 10.50 and greater, Forms Printer installs version XI (11) r2 of Crystal Reports.
That installation means that Forms Printer is compatible with versions 9, 10 and 11 (r1 and r2)
of Crystal reports. Note that Crystal 2008, 2012 and 2014 may also be used but any features
added by these versions will not be available through the Forms Printer version of the Crystal
runtime. So, any reports designed in any of those versions can be run with Forms Printer
version 11.00.

Question: If we purchase Forms Printer do we also have to purchase Crystal Reports?

Answer:  Forms Printer installs all of the files required to run a Crystal Report on a client workstation
that is running Dynamics GP. In order to modify or create Crystal Reports you would typically
purchase at least one copy of Crystal Reports and install it on the report designer’s
workstation. No other Dynamics GP users would need a Crystal License.

Note: Crystal Reports licensing varies in the Terminal Server / Citrix environment. Please
contact Business Objects for details on licensing compliance if using either of those
environments.

Question: Do we have to purchase Adobe Acrobat Writer to print to PDF with Forms Printer?

Answer:  No. Forms Printer installs the Crystal runtime components and SQL Reporting Services files
needed to export to PDF. No additional license or product is needed.

Question: |don’t see the report | want to print when I go Into Forms Printer Setup, why not?

Answer:  Forms Printer prints a very specific list of reports. If the report is not listed in the Forms Printer
setup window, you can use Forms Printer Plus to add the report to any window in your
Dynamics GP solution.

Question: How do | know if | need new Registration Keys for Forms Printer?

Answer:  New registration keys are required whenever you are installing a newer major version release
of Dynamics GP, whenever you are increasing your number of System Manager user licenses,
and when your Registered Dynamics GP Site name is changed.

Question: What version of SQL Server does Forms Printer support?

Answer:  When using the Crystal Reports Engine, SQL Server 2000 and higher are compatible with
Forms Printer.

In order to use SQL Reporting Services as the Reporting Engine you must be using SQL 2005
or higher.

Question: Can | email using a Mail Client other than Outlook?

Answer:  Forms Printer includes specific functionality to support Outlook and can only use Outlook

when using the SQL Server Reporting Services Engine.
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When using the Crystal Reports Engine and Crystal MAPI, any Email client supported by Crystal
Reports can be used. Consult Business Objects’ documentation for Email clients supported by
Crystal Reports.

Question: Why are there tables with names that begin with “ASI” in the report templates?

Answer: In order to mimic the functionality of the Dynamics GP printing processes, Forms Printer must
often create SQL Tables to store data that is generated during the Dynamics GP print process.
When a template contains an “ASI” named table, it is typically required in order to properly
print the report.

Question: Can bar codes be used on Crystal Reports?

Answer: Yes. In order to use a bar code, you need to have a barcode font installed on all workstations
that will print using Forms Printer, and you must modify your report to use that bar code font
for the field(s) to be bar coded. Typically, you would use a calculated field that displayed the
correct start and stop characters for the desired bar code type.

Question: Which Forms Printer Report Setup name maps to which Check Format?

Answer:  From the Print Payroll Checks window, you will see displayed the list of Check Formats. Below
is a list of these formats with their corresponding Forms Printer Setup name:

Check Format _ Forms Printer Setup Name |
Stub on Top - Continuous Employee Checks Stub on Top-D

Stub on Bottom - Continuous Employee Checks Stub on Bottom-D

Stub on Top and Bottom — Single Feed Employee Checks Stub on Bottom-L

Other - Continuous Employee Checks Other -D

Other - Single Feed Employee Checks Other -L

Question: Which Forms Printer Report template maps to which Project Accounting Report?

Answer: A list at the end of this document includes all of the Forms Printer Template file names and
their corresponding Project Accounting Report.

Question: Can Crystal Reports print a MICR bar code?

Answer:  Yes. In order to use the MICR Font for check printing, you must purchase and install a version

of the MICR font then set the MICR field on the Crystal Report to use this Font Type. When
printing MICR Checks, it is also necessary to have a MICR toner cartridge installed in the
printer. You may also want to purchase special Non-duplicatable paper for your check stock.

Sources for MICR and barcode fonts:
http://www.bizfonts.com
http://www.micrfonts.com
http://www.adobe.com/type/main.html
These sources are provided for information only. Accountable Software does not endorse or

support specific products from these companies.

Page |82


http://www.bizfonts.com/
http://www.micrfonts.com/
http://www.adobe.com/type/main.html

Contacting Technical Support

Accountable Software Technical Support is available Monday through Friday from 9:00 am to 5:00 pm EST.
Technical Support can be reached in the following ways:

610.983.3100 (voice)
610.983.3120 (fax)
TechSupport@accountable.com
http://www.accountable.com

When you call, fax, or Email Accountable Software for support, please include the following information:

. Your name
o Your company name and phone number
o The name of the product you are working with and the version you are running (from the

registration window)
o A brief description of the problem.

In addition, have this manual available when you are connected with Customer Support. You may be
directed to various pages in the manual as you receive assistance.

Please also be aware that all technical support issues are chargeable unless the issue you are calling about
is a result of a defect in an Accountable Software product or accompanying documentation. Customers
without pre-paid support incidents, will be required to provide credit card information prior to opening an
incident, but will not be charged if the call is non-billable.

For the latest Accountable Software Support Policies, see the “Support” section of the Accountable
Software Web site at www.accountable.com.
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Project Accounting Report Mapping

Below is the list of Sample reports and the Project Accounting report these samples are designed to support. It is important during Forms Printer
setup, that the correct sample report be used when creating these mappings. These reports are not interchangeable, you must use the correct

report or you will receive no data, incorrect data or an error.

Billing Format Name
T&M Summary A

Forms Printer Setup / Report Writer Name

PA Billing Summary A Report Format

. Forms Printer Template Report Name

PA Billing Summary A.rpt

T&M Summary B

PA Billing Summary B Report Format

PA Billing Summary B.rpt

T&M Summary C

PA Billing Summary C Report Format

PA Billing Summary C.rpt

T&M Detailed A

PA Billing Detailed A Report Format

PA Billing Detailed A.rpt

T&M Detailed B

PA Billing Detailed B Report Format

PA Billing Detailed B.rpt

T&M Detailed C

PA Billing Detailed C Report Format

PA Billing Detailed C.rpt

T&M Consulting Project

PA Billing Invoice Format - Invoice Format 1

PA Billing Invoice Format 1,2,5,6.rpt

T&M Consulting Project With Tax Detail

PA Billing Invoice Format - Invoice Format 2

PA Billing Invoice Format 1,2,5,6.rpt

T&M Consulting Contract

PA Billing Invoice Format - Invoice Format 3

PA Billing Invoice Format 3,4,7,8.rpt

T&M Consulting Contract With Tax Detail

PA Billing Invoice Format - Invoice Format 4

PA Billing Invoice Format 3,4,7,8.rpt

T&M Detailed Project

PA Billing Invoice Format - Invoice Format 5

PA Billing Invoice Format 1,2,5,6.rpt

T&M Detailed Project With Tax Detail

PA Billing Invoice Format - Invoice Format 6

PA Billing Invoice Format 1,2,5,6.rpt

T&M Detailed Contract

PA Billing Invoice Format - Invoice Format 7

PA Billing Invoice Format 3,4,7,8.rpt

T&M Detailed Contract with Tax Detail

PA Billing Invoice Format - Invoice Format 8

PA Billing Invoice Format 3,4,7,8.rpt

T&M Pre-Billing Worksheet

PA Billing Invoice Format - Invoice Format 9

PA Billing Invoice Format 9-14.rpt

T&M Basic

PA Billing Invoice Format - Invoice Format 10

PA Billing Invoice Format 9-14.rpt

T&M Invoice 1

PA Billing Invoice Format - Invoice Format 11

PA Billing Invoice Format 9-14.rpt

T&M Invoice 2

PA Billing Invoice Format - Invoice Format 12

PA Billing Invoice Format 9-14.rpt

T&M Invoice 3

PA Billing Invoice Format - Invoice Format 13

PA Billing Invoice Format 9-14.rpt

T&M Invoice 4

PA Billing Invoice Format - Invoice Format 14

PA Billing Invoice Format 9-14.rpt

CP/FP Document Level Invoice

PA Invoice Format CP/FP Document Level Invoice

PA Invoice Frmt CP-FP.rpt

CP/FP Contract Level Invoice

PA Invoice Format CP/FP Contract Level Invoice

PA Invoice Frmt CP-FP.rpt

CP/FP Project Level Invoice

PA Invoice Format CP/FP Project Level Invoice

PA Invoice Frmt CP-FP.rpt

CP/FP Contract/Project Level Invoice

PA Invoice Frmt CP-FP.rpt
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Billing Format Name Forms Printer Setup / Report Writer Name Forms Printer Template Report Name |

CP/FP Pre-Billing Worksheet

PA Invoice Format CP/FP Pre Billing Worksheet

PA Invoice Frmt CP-FP.rpt

CP/FP Basic

PA Invoice Format CP/FP Basic

PA Invoice Frmt CP-FP.rpt

CP/FP Invoice 1

PA Invoice Format CP/FP Invoice 1

PA Invoice Frmt CP-FP.rpt

CP/FP Invoice 2

PA Invoice Format CP/FP Invoice 2

PA Invoice Frmt CP-FP.rpt

Fee Document Level Invoice

PA Invoice Format Fee Document Level Invoice

PA Invoice Frmt Fee Document Level.rpt

Fee Contract Level Invoice

PA Invoice Format Fee Contract Level Invoice

PA Invoice Frmt Fee Contract Level.rpt

Fee Project Level Invoice

PA Invoice Format Fee Project Level Invoice

PA Invoice Frmt Fee Project Level.rpt

Fee Contract/Project Level Invoice

PA Invoice Format Fee Contract/Project Level Invoice

PA Invoice Frmt Fee Contract - Project Level.rpt

Detail Page - Document Level Invoice

PA Invoice Format Document Detail Page 1

PA Invoice Doc, Con, Proj, Con-Proj Detail.rpt

Detail Page - Contract Level Invoice

PA Invoice Format Contract Detail Page 1

PA Invoice Doc, Con, Proj, Con-Proj Detail.rpt

Detail Page - Project Level Invoice

PA Invoice Format Project Detail Page 1

PA Invoice Doc, Con, Proj, Con-Proj Detail.rpt

Detail Page - Contract/Project Invoice

PA Invoice Format Contract/Project Detail Page 1

PA Invoice Doc, Con, Proj, Con-Proj Detail.rpt

Summary Page - Document Level Invoice 1

PA Invoice Format Document Summary Page 1

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Document Level Invoice 2

PA Invoice Format Document Summary Page 2

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Document Level Invoice 3

PA Invoice Format Document Summary Page 3

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Document Level Invoice 4

PA Invoice Format Document Summary Page 4

PA Invoice Frmt Doc, Con, Proj Sum Pgl-5.rpt

Summary Page - Document Level Invoice 5

PA Invoice Format Document Summary Page 5

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Contract Level Invoice 1

PA Invoice Format Contract Summary Page 1

PA Invoice Frmt Doc, Con, Proj Sum Pgl-5.rpt

Summary Page - Contract Level Invoice 2

PA Invoice Format Contract Summary Page 2

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Contract Level Invoice 3

PA Invoice Format Contract Summary Page 3

PA Invoice Frmt Doc, Con, Proj Sum Pgl-5.rpt

Summary Page - Contract Level Invoice 4

PA Invoice Format Contract Summary Page 4

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Contract Level Invoice 5

PA Invoice Format Contract Summary Page 5

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Project Level Invoice 1

PA Invoice Format Project Summary Page 1

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Project Level Invoice 2

PA Invoice Format Project Summary Page 2

PA Invoice Frmt Doc, Con, Proj Sum Pgl-5.rpt

Summary Page - Project Level Invoice 3

PA Invoice Format Project Summary Page 3

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

Summary Page - Project Level Invoice 4

PA Invoice Format Project Summary Page 4

PA Invoice Frmt Doc, Con, Proj Sum Pgl-5.rpt

Summary Page - Project Level Invoice 5

PA Invoice Format Project Summary Page 5

PA Invoice Frmt Doc, Con, Proj Sum Pgl1-5.rpt

IV Document Level Invoice

PA Invoice Format IV Document Level Invoice

PA Inv Frmt IV Document Level.rpt

IV Contract Level Invoice

PA Invoice Format IV Contract Level Invoice

PA Inv Frmt IV Contract Level.rpt

IV Project Level Invoice

PA Invoice Format IV Project Level Invoice

PA Inv Frmt IV Project Level.rpt

IV Contract/Project Level Invoice

PA Invoice Format IV Contract/Project Level Invoice

PA Inv Frmt IV Cont-Proj Level.rpt
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Billing Format Name Forms Printer Setup / Report Writer Name Forms Printer Template Report Name

GST PA Billing Blank Invoice Form GST PA Billing Blank Invoice Form PA Billing GST Invoice.rpt
GST PA Billing Blank Return Form GST PA Billing Blank Return Form PA Billing GST Invoice.rpt
GST PA Billing Blank History Invoice Form GST PA Billing Blank History Invoice Form PA Billing GST Invoice.rpt
GST PA Billing Blank History Return Form GST PA Billing Blank History Return Form PA Billing GST Invoice.rpt
PO Format A (Project Accounting Only) PO Format A PA PO Format 1-3.rpt
PO Format B (Project Accounting Only) PO Format B PA PO Format 1-3.rpt
PO Format C (Project Accounting Only)) PO Format C PA PO Format 1-3.rpt
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